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LabPlot is een programma voor het maken van twee- en driedimensionale plots van functies en het analyseren
van gegevens.
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LabPlot is een programma voor het maken van twee- en driedimensionale grafieken van
gegevensverzamelingen en functies. In LabPlotkunt u met meerdere plots werken waarin meerdere grafieken
aanwezig zijn. De grafieken kunnen worden gemaakt aan de hand van gegevens of van functies.

Alle instellingen van een complete verzameling van plots kunnen in een projectbestand worden opgeslagen.
Deze projectbestanden kunnen worden geopend met behulp van parameters op de opdrachtregel, met het
menu Bestand, of door slepen en neerzetten.

Elk object (titel, legenda, assen, tekst bij de assen) kan met de muis worden gesleept. Door op een object te
dubbelklikken wordt het erbij behorende dialoogvenster geopend waarin de opties van het object kunnen
worden gewijzigd.

De instellingen van een plot/grafiek kunnen ook worden gewijzigd in het menu Uiterlijk. Met het menu

Bewerken kunnen gegevensverzamelingen en functies (grafieken) worden toegevoegd die in dezelfde of in
een andere plot kunnen worden afgebeeld.

De ontwikkelingsgeschiedenis van LabPlot
¢ Versie 1.5.1 (27 Maart, 2006)

¢ nieuwe analysefuncties: ruis, signaalfilter, auto/kruiscorrelatie en geschiktheidsanalyse
e dialoog voor grafiek toevoegen in grafiekendialoog
e verbeterde dialoog voor toekennen van waarde in rekenblad

Chapter 1. Inleiding
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¢ ondersteuning voor paneelplots en verbeterde oppervlakteplot en taartdiagram
e sterk verbeterde verkennerdialoog met slepen en neerzetten
® opslaan en herstellen van positie/grootte van een blad in project
e statisticken van kolommen/rijen en inpassen in rekenbladen
¢ nieuwe stijl voor schaalstreepjes en het opvullen tussen krommen
¢ ondersteuning voor "richtext" in legenda
¢ instellingen opslaan en open dialogen bijwerken
e optioneel xml-projectformaat (wordt later als standaardformaat gebruikt)
e vele verbeteringen van fouten
® Versie 1.5.0 (15 augustus, 2005)

® meer gewichtsfuncties+restwaarden voor regressie/niet-lineaire aanpassing
® Wavelet- en Hankeltransformaties toegevoegd en verbeterde analysefuncties
e verbeterde oppervlakte- en qwt 3d-plot
e verbeterd gedrag bij niet-lineaire schalen en ondersteuning voor LaTeX-teksten
® import/export gegevens van/naar PostgreSQL, mySQL, enz. via KexiDB
¢ import Origin opj-projecten (alleen Origin-werkbladen)
e betere ondersteuning voor het maken van scripts
e vele verbeteringen van fouten
® Versie 1.4.1 (28 maart, 2005)

® niet-lineaire aanpassing van zelfgedefinieerde functies met tot 9 parameters
¢ instellen standaard plotstijl en symbolen
e kopiéren van grafieken en wissen/kopiéren van plots
e verbeterde import/export-instellingen met ondersteuning voor binaire gegevens
® meer functies voor analyse : comprimeren, top zoeken, periodieke, periode-vergelijking
e regressie/niet-lineaire aanpassing van gegevens met foutbalken
¢ snelle modus voor grote gegevensverzamelingen en gegevensmodus voor het beschouwen
van gegeven punten
e zoomin/zoomuit, merkteken en verbeterd assenstelsel
¢ maskeren gegeven punten in rekenblad en plot
e Versie 1.4.0 (15 december, 2004)

e veelzijdig rekenblad met invoer gegevens, bewerken, enz.
¢ nieuwe 3d-plot met rotatie en kleurkaarten (met gebruik van qwtplot3d-bibliotheek)
e dubbelgebufferd plotten (trillingvrij beeld)
e bewerkingen op gevensverzameling
¢ import/export van ruim 80 afbeeldingformaten (svg, fits,...) en betere behandeling van
afbeeldingen
e directe export naar ps, eps, pdf via ghostscript
¢ ecenvoudig maken van scripts met QSA
¢ Versie 1.3.1 (30 augustus, 2004)

¢ ingebouwde export naar svg, eps en nog andere grafische formaten

¢ ondersteuning voor ternaire- en pooldiagrammen

¢ (de)convolutie en interpolatie toegevoegd

e beter zoomen, plotten van foutbalken en aantekeningen maken bij waarden

® meer plotsymbolen en penseel

® lezen en schrijven van netcdf-, cdf- en audio- (wav, au, snd,aiff,...) bestanden
e verbeterde dialoog grafiekenlijst

¢ nieuwe dialoog bestandsinformatie

De ontwikkelingsgeschiedenis van LabPlot



Het handboek van LabPlot
¢ Versie 1.3.0 (14 juni, 2004)

® meerdere plots in een werkblad
¢ hanteren van tijd- en datumformaat
e verbeterde as-instellingen
e verbeterde oppervlakte- (dichtheid, contour) plots
e verbeterde niet-lineaire aanpassing
¢ ondersteuning voor taartdiagrammen
¢ verbeterde documentatie
¢ Duits handboek
® Versie 1.2.3 (16 februari, 2004)

® lineaire regressie en niet-lineaire aanpassing
e verbeterde Fouriertransformatie met behulp van gsl of fftw
e integratie, differenties en histogrammen
¢ met de muis maken, bewerken en verplaatsen van tekenobjecten
e lezen/schrijven van gecomprimeerde gegevens (gzip, bzip2)
e KDE-KPart voor LabPlot-projectbestanden
® meer verbeteringen van fouten en verbeterde Duitse vertaling
® Versie 1.2.2 (17 december, 2003)

e Jogaritmische schaalverdeling assen
¢ ondersteuning voor tekenobjecten
¢ ondersteuning voor speciale functies en verdelingen van gsl
e fouriertransformatie via gsl
e exporteren naar pdf, fig, dxf, enz. via pstoedit
e exporteren naar > 100 verschillende afbeeldingsformaten via ImageMagick
® meer verbeteringen van fouten
® Versie 1.2.1 (26 oktober, 2003)

o sterk verbeterde grafische interface
e betere inpassing in KDE
e titel en teksten bij de assen in "richtext"
e verbeterde 3d-plots
¢ nieuwe functies voor analyse
e beter lezen van gegevens
¢ instellen en opslaan van instellingen van de gebruiker
® voorbeelden
¢ Versie 1.2.0 (8 september, 2003)

¢ nieuwe verbeterde interne plotstructuur
¢ ondersteuning voor het "parsen” van functies met meer parameters
¢ nieuwe oppervlakteplot met contouren en legenda
e ondersteuning voor JPEG2000 en tiff
e gebruikershandleiding (dit handboek)
® meer verbeteringen van fouten
® Versie 1.1.1 (26 juli, 2003)

® matrix-gegevens-lezen
e dichtheidplots van functie en gegevens

e "parser” (programma voor lezen en herkennen van invoer) geheel herschreven

De ontwikkelingsgeschiedenis van LabPlot
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e afdrukken in kleur en op schaal
e plot exporteren als afbeelding
¢ meer flexibel lezen van gegevens
e verbeterde tekst bij schaalstreepjes op de assen (formaat en plaats)
® meer verbeteringen van fouten
¢ Versie 1.1 (22 juni, 2003)

® meer eigenschappen van objecten (kleur titel, kleur rooster, enz.)
¢ ondersteuning voor 2d-foutbalken
® slepen en neerzetten van de titel, de assen met correcte herschaling
e verbeterd opslaan en openen van alle plots in een projectbestand
e vele verbeteringen van fouten
® Versie 1.0.3 (11 mei, 2003)

¢ plotlijst in de menubalk

e verbeterd beheer van de werkruimte

® slepen en neerzetten van de legenda

® Bewerkingdialoog voor het bewerken van gegevens
e Versie 1.0.2 (4 april, 2003)

¢ plot verschuiven met knoppen voor hulpmiddelen

e schalen van plot met knoppen voor hulpmiddelen

¢ openen van dialoogvensters met een muisklik

e verbeterde voorbeeldweergave voor het afdrukken
® Versie 1.0.1 (18 maart, 2003)

¢ voorbeeldweergave voor het afdrukken geimplementeerd
e grafieknaam anders dan de naam geintroduceerd
e Versie 1.0 (3 maart, 2003; naar LabPlot hernoemd)

e ondersteuning voor KDE 3.0 en KDE 2.x
¢ automake- en autoconf-scripts (./configure)
® Versie 0.9.x (26 februari, 2003)

e verbeterde Gegevensdialoog

e ecen plot openen en opslaan

® begonnen met i18n (de)

® begonnen met de migratie van Qt? naar KDE

e verbeterde Lijstdialoog

¢ veranderen van grafieken van gegevens en functies in de Lijstdialoog

¢ ondersteuning van rooster in 2d- en 3d-plots
e Versie 0.4.0 (7 oktober, 2002)

® ondersteuning voor 3d-plots

¢ gebruiken van Grafiekenlijst voor het bewaren van alle grafieken in een plot

e beter schalen van de gehele plot
¢ nieuwe klasse GraphM voor de ondersteuning van matrix-gegevens
¢ Versie 0.2.1 (30 juni, 2001)

® [ egenda in plot
e Lijstdialoog voor alle grafieken in een plot

De ontwikkelingsgeschiedenis van LabPlot
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¢ Versie 0.2 (16 juni, 2001)

e cerste "plotwidget" met een enkele grafiek
¢ aanmaken van gegevens via Functiedialoog
e Versie 0.1 (20 mei, 2001; eerste uitgave met de naam QPlot)

Chapter 2. Eigenschappen

In dit hoofdstuk wordt getracht een complete lijst te geven van alle eigenschappen van LabPlot.
maken van 2d- en 3d-plots van gegevens en functies

o flexibel lezen/schrijven van gegevens in verschillende formaten (zoals cdf, netcdf, audio, binair,
afbeeldingen, gegevensbestanden)

¢ lezen en schrijven van afbeeldingen en gecomprimeerde gegevens

e uitvoerige "parser”" (programma voor het lezen en herkennen van invoer) voor het zelf maken van 2d,
3d-functies

¢ ondersteuning voor alle functies en constanten in de GNU Scientific Library (gsl, GNU
wetenschappelijke bibliotheek)

* maken van oppervlakteplots, pooldiagrammen, ternaire diagrammen en taartdiagrammen van functies
en gegevensbestanden

¢ flexibele 3d-plot met rotatie

® meerdere plots in een werkblad

® bewerkingen op gevensverzameling

¢ snelle modus voor grote gegevensverzamelingen en gegevensmodus voor het beschouwen van
gegeven punten

Gemakkelijk bewerken van plots

e kopiéren van grafieken en wissen/kopiéren van plots

e veelzijdig rekenblad voor het werken met gegevens

¢ dubbelklikken opent gedetailleerde dialogen voor alle instellingen
e clk object kan met de muis worden gesleept

¢ "online" schalen en verschuiven van plots

¢ ondersteuning voor teksten in LaTeX en "richtext"

¢ berekenen van expressies en direct bewerken van gegevens

e statistische informatie over gegevens

e tekenobjecten te bewerken met muis

e verschillende manieren van zoomen, maskeren van gegeven punten en merkteken
e dialoog voor grafiek toevoegen in grafiekendialoog

¢ ondersteuning voor paneelplots

analyse van gegevens en functies

¢ middelen, gladstrijken en weglaten van gegevens

e comprimeren, periodieke analyse en analyse door periodes te vergelijken
¢ zoeken van extremen

e interpolatie (splines, enz.)

e differenties

® integreren

Chapter 2. Eigenschappen 7
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® histogram

e regressie (tot 10de orde)

® niet-lineaire aanpassing (ook van zelf gedefinieerde functie met tot 9 parameters)
e Fourier-, Hankel en wavelet-transformaties

¢ (de)convolutie

¢ werken met afbeeldingen

® ruis, signaalfilter en auto/kruiscorrelatie

e geschiktheidsanalyse

LabPlot-projectbestanden

¢ ondersteuning voor verschillende werk- en rekenbladen met behulp van MDI

¢ opslaan en openen van alle werk- en rekenbladen in een projectbestand (*.1pl)

¢ bewerkbare projectinformatie

e exporteren van werkbladen als afbeelding, in ps-, eps-, svg-, pdf- en nog veel meer formaten (met
gebruik van pstoedit of ImageMagick)

® import/export gegevens van/naar PostgreSQL, mySQL, enz. via KexiDB

e vele voorbeelden van projectbestanden

e optioneel xml-projectformaat (wordt later als standaardformaat gebruikt)

¢ importeren van Origin opj-projecten

KDE-uiterlijk en manier van werken

¢ instellen standaard plotstijl en symbolen

e afdrukken en ingebedde voorweergave van afdruk

¢ ondersteuning voor slepen en neerzetten

e KPart voor LabPlot-projecten

e KDE-handboek (Engels en Duits)

¢ het maken van scripts met behulp van Script for Applications (QSA; Qt-Script voor toepassingen) van

Qt?

Chapter 3. LabPlot gebruiken

Table of Contents

Opties op de opdrachtregel

Een bestand opgeven

Andere opties op de opdrachtregel
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Op zijn plaats zetten met de muis
Statusbalk

Gereedschapbalk aan de zijkant

Opties op de opdrachtregel
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Een bestand opgeven
Bij het opstarten van LabPlot op de opdrachtregel kunt u de naam opgeven van een projectbestand:

LabPlot [bestandnaam. 1pl...]

Andere opties op de opdrachtregel
De volgende opties voor hulp op de opdrachtregel zijn beschikbaar

LabPlot ——help
U krijgt een lijst van enkele basisopties die op de opdrachtregel beschikbaar zijn.
LabPlot ——help-gt
U krijgt een lijst van de opties die beschikbaar zijn voor het wijzigen van de manier waarop LabPlot
met Qt? samenwerkt.
LabPlot ——help-kde
U krijgt een lijst van de opties die beschikbaar zijn voor het wijzigen van de manier waarop LabPlot
met KDE samenwerkt.
LabPlot ——help-all
U krijgt een lijst van alle opties die op de opdrachtregel beschikbaar zijn.
LabPlot -—no-splash
Het scherm met de naam en de versie van het programma wordt niet getoond
LabPlot ——author
U krijgt de naam van de auteur van LabPlot in het tekstscherm
LabPlot ——version
U krijgt de versie-informatie voor Qt?, KDE en LabPlot. Is ook beschikbaar met LabPlot —v

Het Rekenblad (Spreadsheet)

A {time) [X] B {doubie} v C {doutia} (2] *
34 AT 30ATE 1
PRI 50.26409122 07
3 o0 46 37009422 L47TTS
& 00-37:30 =33 BO00LIZE D&azTs
5 04T 1513517 0303
5 oesTm 1 oHTELTZ LSS
1 oLerdn 42 26160172 203
u 030730 2645933172 -0 0445
TR A4 5NIMI 2151
10 023700 41 B41BNLTE 0 B0ZI5
1L 023730 2 BEL2EET2 0006490
12 03 47:30 B 1EB4E520 <0018
13 03T AR BETITE 215378
14 036700 5. T49T8TE 20215
15 046730 A TR 033075
_:I.l: O4-17:30 50 4450TI2E -0168375
PR e 3. 39900677 QDTS
1B 043700 7 FTEEE 058ZIS
18 044730 B SL63TITE 0BELTS
20 044730 45 EBA2 36T 071478
2L 050730 AR ATILESTT -0 1367T%
PP e 4. 36240028 0107
23 061730 4 9M5ITE BTy
24 063730 I3 UM0EETE el @

Het rekenblad is het belangrijkste onderdeel van LabPlot voor het werken met gegevens. Voor het beheer en
het omzetten van gegevens bevat het rekenblad een aanpasbare tabel. Iedere kolom in de tabel heeft een
bepaalde naam en kan een formaat toegewezen krijgen (zoals double of datetime (dubbele precisie of
datumtijd)).

Een bestand opgeven
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U kunt importeren met de import-dialoog. Elke functie van het rekenblad kunt u bereiken via het contextmenu
(rechtsklikken). U kunt in de rekenbladen onderling knippen, kopiéren en plakken, gegevens aanvullen,
normaliseren en omzetten en tenslotte ook plots maken aan de hand van uw gegevens. Natuurlijk kunt u hier
ook de gegevens in het rekenblad exporteren.

Vanaf versie 1.4.1 kunt u bepaalde gegeven punten in het rekenblad maskeren die daarna bij het plotten niet

worden gebruikt. Het maskeren van gegeven punten kan later in de dialoog voor de grafiekenlijst worden
beinvloed.

Het Werkblad

Workahast 1 el
‘Worksheet 1

Iion vy 24 000233 2004

Het werkblad bevat alle plots en tekenobjecten. U kunt het werkblad aanpassen in de dialoog voor het
werkblad.

Het werkblad kan meerdere plots bevatten met verschillende eigenschappen. Om de plots te rangschikken of

op elkaar te leggen in het werkblad kunt u de menu-ingangen "Plots schikken" of "Plots over elkaar"
gebruiken.

Slepen en neerzetten

In LabPlot wordt de werkwijze van KDE en Qt? voor het slepen en neerzetten ondersteund. Dit betekent dat u
een project kunt openen door het symbool ervan te slepen naar het venster van LabPlot. Projectbestanden
moeten de extensie . 1pl hebben.

Op zijn plaats zetten met de muis

In LabPlot wordt het slepen met de muis ondersteund van de assen, de titel, de legenda en de teksten bij de
assen.

Om iets te verplaatsen moet erop worden geklikt met de left mouse button. Bij het verplaatsen van de muis

met ingedrukte left mouse button wordt de positie in de plot voortdurend bijgewerkt, totdat de muisknop
wordt losgelaten.

Het Rekenblad (Spreadsheet) 10
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Statusbalk

De horizontale en verticale posities van de muisaanwijzer in het plotgebied worden in gegevenseenheden
getoond links in de statusbalk onder in het venster van LabPlot.

Gereedschapbalk aan de zijkant

In de gereedschapbalk aan de zijkant zijn vele functies gemakkelijk toegankelijk. U kunt hier zoomen,
verplaatsen of schalen van een plot kiezen. Ook kunt u hier meer gevorderde functies selecteren zoals
gegevensmodus (om afzonderlijke gegeven punten te beschouwen) of het maskeren van gegeven punten. Voor
nadere informatie zie hier.

Chapter 4. Overzicht van opdrachten
Table of Contents

Het menu Bestand
Het menu Bewerken
Het menu Beeld

Het menu Rekenblad

Het menu Analyse

Het menu Uiterlijk
Het menu Tekenen

Het menu Bladen
Het menu Grafieken

Het menu Scripts

Het menu Instellingen
Het menu Help
Hoofdwerkbalk

Gereedschapbalk aan de zijkant

Het menu Bestand

Bestand->Nieuw (Ctrl-n)
Aanmaken van een nieuw projectbestand in LabPlot.

In een projectbestand worden alle instellingen en alle plots bewaard in ASCII-formaat.
Bestand->Openen (Ctrl-o)

Openen van een projectbestand voor LabPlot.
Festand->RRecent geopend

Openen van een recent in LabPlot geopend bestand.

U ziet hier de lijst van de 10 laatst gebruikte projectbestanden.
Bestand->Opslaan (Ctrl-s)
Opslaan van het huidige project.

Indien u het project voor de eerste keer opslaat wordt het opgeslagen met een tijdelijke naam voor een
projectbestand.
Bestand->Oslaan als (Ctrl-a)

Statusbalk 11
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Opslaan van het huidige project onder een andere naam.
Bestand->OpenenXML
Openen van een project uit een XML-bestand in LabPlot.
File->Opslaan alsXML
Opslaan van een project in een XML-bestand in LabPlot.
Bestand->Project Info (Alt-v)
In deze dialoog heeft u de mogelijkheid enkele bij het project behorende opties te beschouwen en te
wijzigen zoals titel, auteur, aanmaakdatum, enz. Deze informatie wordt opgeslagen in het
projectbestand. Dit kan worden gebruikt om enige nadere informatie over een project te bewaren.
Bestand->Projectverkenner (Ctrl->)
In deze dialoog krijgt u een overzicht van de structuur van een project. In toekomstige versies kunt u
hier mogelijk meer mogelijkheden aantreffen zoals het toevoegen en wissen van grafieken, plots en
werkbladen.
Bestand->Import (Ctrl-Shift-1)
Gegevens importeren in het actieve rekenblad

U kunt hiermee gegevens importeren in LabPlot. Meer hierover kunt u lezen in de sectie
Importdialoog.

Bestand->Import OPJ-project (Ctrl-Shift-j)
OPJ-project importeren

U kunt hiermee OPJ-projecten van Origin in LabPlot importeren.
Bestand->Export naar afbeelding (Ctrl-r)
Actieve plot opslaan als een afbeelding.

Hiermee is het mogelijk de actieve plot op te slaan als een afbeelding. Verschillende formaten zijn

hierbij mogelijk zoals: bmp, jpg, jpg2000, pbm, pgm, png, ppm, tiff, xbm en xpm.
Bestand->Export naar ... (Ctrl-o0)

Actieve plot in een speciaal formaat opslaan.

Thans ondersteund zijn: Postscript (PS), Encapsulated Postscript (EPS), Portable Document Format

(PDF), Scalable Vector Graphics (SVG) en het oorspronkelijke QPicture Format (PIC).
Bestand->Export via pstoedit (Alt-e)

Actieve plot naar diverse formaten exporteren.

Hiermee kunt u de actieve plot naar diverse formaten exporteren via pstoedit. Ondersteund worden:
dxf, fig, eps, en nog veel meer.

Bestand->Export via ImageMagick (Alt-i)
Actieve plot exporteren naar verschillende afbeeldingformaten.

Hiermee kunt u de actieve plot exporteren naar verschillende afbeeldingformaten via ImageFormats.
Meer dan 100 verschillende formaten worden ondersteund! Zie ook de documentatie van
ImageMagick voor meer informatie.

Bestand->Afdrukken (Ctrl-p)
Actieve plot afdrukken.

Er wordt een afdrukdialoog geopend waarin u de printer kunt selecteren, verschillende
papierafmetingen, enz.

Bestand->Afdrukvoorbeeld (Alt-p)
Een afdrukvoorbeeld openen.

Het menu Bestand 12



Het handboek van LabPlot

Hiermee wordt een ingebed afdrukvoorbeeld in liggend A5-formaat geopend van de actieve plot. Een
actief afdrukvoorbeeld kunt u hiermee afsluiten.

Bestand->Afsluiten (Ctrl-q)
LabPlot afsluiten.

Het menu Bewerken

Bewerken->Nieuwe 2d-plot (Ctrl-Shift-n)

Openen van een nieuwe lege 2d-plot in het huidige werkblad.
Bewerken->Nieuwe Oppervlakteplot (Alt-z)

Openen van een nieuwe lege oppervlakteplot in het huidige werkblad.
Bewerken->Nieuwewe 3d-plot (Ctrl-m)

Openen van een nieuwe lege 3d-plot in het huidige werkblad.
Bewerken->Nieuwe QWT 3d-plot (Ctrl-Shift-q)

Openen van een nieuwe lege QWT 3d-plot in het huidige werkblad.
Bewerken->Nieuw taartdiagram (Alt-.)

Openen van een nieuw leeg taartdiagram in het huidige werkblad.
Bewerken->Nieuww pooldiagram (Ctrl-Shift-o)

Openen van een nieuw leeg pooldiagram in het huidige werkblad.
Bewerken->Nieuw ternair diagram (Ctrl-Shift-t)

Openen van een nieuw leeg ternair diagram in het huidige werkblad.
Bewerken->Actieve plot Wissen (Alt-q)

Wissen van de actieve plot in het huidige werkblad.
Bewerken->Kopie van Actief blad (Alt->)

Een kopie maken van het actieve rekenblad/werkblad.
Bewerken->Nieuw Rekenblad (Ctrl-Shift-S)

Openen van een nieuw rekenblad.
Bewerken->Nieuw Werkblad (Alt-x)

Openen van een nieuw werkblad.
Plotten->Grafieklijst (Ctrl-g)

Openen van de dialoog Grafiekenlijst.

In de lijstdialoog kunt u de grafieken in de actieve plot manipuleren. U kunt ook in deze dialoog
komen door op een plot te dubbelklikken.

Plotten->Plotlijst (Ctrl-Shift-.)
Openen van de plotlijstdialoog.

In de plotlijstdialoog kunt u de grafieken in het actieve werkblad manipuleren.
Plotten->Nieuwe plot van Functie
Openen van de functiedialoog.

Hierme opent u de functiedialoog voor het maken van een plot van een door de gebruiker
gedefinieerde functie.

Plotten->Nieuwe plot van functie->2d-functie (Ctrl-e)
Openen van de dialoog voor 2d-functies.

Hiermee opent u de functiedialoog voor het maken van een 2-dimensionale grafiek van een door de
gebruiker gedefinieerde functie.

Plotten->Nieuwe plot van functie->2d- oppervlaktefunctie (Ctrl-u)
Openen van de dialoog voor 2d-oppervlaktefuncties.
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Hiermee opent u de functiedialoog voor het maken van een 2-dimensionale oppervlaktegrafiek van
een door de gebruiker gedefinieerde functie.

Plotten->Nieuwe plot van functie->Pooldiagram (Alt-<)
Openen van de dialoog voor functies in poolcodrdinaten.

Hiermee opent u de functiedialoog voor het maken van een 2-dimensionaal pooldiagram van een
functie in poolcodrdinaten.

Plotten->Nieuwe plot van functie->3d- functie (Ctrl-f)
Openen van de dialoog voor 3d-functies.

Hiermee opent u de functiedialoog voor het maken van een 3-dimensionale grafiek van een door de
gebruiker gedefinieerde functie.

Plotten->Niewe plot van gegevens
Openen van de dialoog voor gegevens.

Hiermee opent u de gegevensdialoog voor het maken van een plot aan de hand van gegevens.
Plotten->Nieuwe plot van gegevens->2d-gegevens (Ctrl-d)
Openen van de dialoog voor 2d-gegevens.

Hiermee opent u de gegevensdialoog voor het maken van een 2-dimensionale grafiek van een
gegevensbestand. U kunt vele opties opgeven voor het lezen van gegevens, u moet dus in staat zijn
hier elk type te lezen van ASCII-gegevens.

Plotten->Nieuwe plot van gegevens->2d-oppervlaktegegevens (Alt--)
Openen van de dialoog voor 2d-oppervlaktegegevens.

Hiermee opent u de gegevensdialoog voor het maken van een 2-dimensionale oppervlaktegrafiek van
een gegevensbestand.

Plotten->Nieuwe plot van gegevens->Taartgegevens (Alt-,)
Openen van de dialoog voor taartgegevens.

Hiermee opent u de gegevensdialoog voor het maken van een 2-dimensionaal taartdiagram van een
gegevensbestand.

Plot->Nieuwe plot van gegevens->Polaire gegevens (Ctrl-,)
Openen van de dialoog voor polaire gegevens.

Hiermee opent u de gegevensdialoog voor het maken van een 2-dimensionaal pooldiagram van een
gegevensbestand.

Plotten->Nieuwe plot van gegevens->Ternaire gegevens (Ctrl-Shift-Y)
Openen van de dialoog voor ternaire gegevens.

Hiermee opent u de gegevensdialoog voor het maken van een 2-dimensionaal ternair diagram van een
gegevensbestand.

Bewerken->Nieuwe plot van gegevens->3d-gegevens (Ctrl-i)
Openen van de dialoog voor 3d-gegevens.

Hiermee opent u de gegevensdialoog voor het maken van een 3-dimensionale grafiek van een
gegevensbestand. U kunt vele opties opgeven voor het lezen van gegevens, u moet dus in staat zijn
hier elk type te lezen van ASCII-gegevens.

Plotten->Nieuwe plot van gegevens->QWT 3d-gegevens (Ctrl-Shift-B)
Openen van de dialoog voor QWT 3d-gegevens.
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Hiermee opent u de gegevensdialoog voor het maken van een 3-dimensionale qwt-plot van een
gegevensbestand.

Plotten->Snelle modus
Snelle modus aan- en uitzetten

Hiermee kunt u de snelle modus aan- en uitzetten. In de snelle modus kan het tekenen van een grafiek

van een grote gevensverzameling worden versneld door slechts een beperkt aantal gegeven punten te

gebruiken. Het aantal gegeven punten kan worden geselecteerd in de instellingen-dialoog.
Bewerken->Wissen (Ctrl-c)

De actieve plot wissen. Hiermee worden alle grafieken in de actieve plot gewist zodat u een lege plot

overhoudt, zoals na een "Nieuwe 2D/3D/Oppervlakte/Taart -plot of -diagram".

Ook als het actieve blad een rekenblad is wordt dat gewist.
Bewerken->Afsluiten (Ctrl-w)
Afsluiten van het actieve blad. Hiermee kunt u ook het afdrukvoorbeeld afsluiten.

Het menu Beeld

In dit menu vindt u alles dat ook in de gereedschapbalk aan de zijkant aanwezig is.

Het menu Rekenblad

In dit menu vindt u alles dat ook aanwezig is in het contextmenu (rechtse muisklik) van een rekenblad. Indien
er geen rekenblad actief is kunt u een nieuw rekenblad toevoegen.

Het menu Analyse

Leest u ook de uitvoerige informatie over de analyse-functies.

Analyse->Vergelijking berekenen (Ctrl-#)
Berekenen van elke vergelijking
Analyse->Bewerkingen op gegevensverzameling (Ctrl-Shift-d)
Openen van de dialoog voor bewerkingen

Hier kunt u bewerkingen uitvoeren op gegevensverzamelingen, zoals optellen of vermenigvuldigen
van .de waarden van twee grafieken.

Analyse->Periodiek->Periodieke functie (Ctrl-Shift-k)
Openen van de Periodiekdialoog

U kunt periodieke gegevens onderzoeken.
Analyse->Periodiek->Beschouwing per periode (Ctrl-Shift-u)
Opent de dialoog voor de beschouwing per periode

U kunt periodieke gegevens comprimeren.
Analyse->Top zoeken (Ctrl-Shift-x)

Openen van de dialoog voor het zoeken van uiterste waarden

Hier kunt u de uiterste waarden vinden in een gegevensverzameling.
Analyse->Histogram (Alt-h)
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Openen van de histogramdialoog

Hier kunt u een histogram maken van elke grafiek. Kies in deze dialoog het interval en de klassen
voor dit histogram.

Hiervoor moet gsl zijn geinstalleerd (Gnu Scientific Library: Gnu wetenschappelijke bibliotheek).
Analyse->Interpolatie (Alt-i)
Openen van de dialoog voor interpolatie

Hier kunt u elke grafiek interpoleren. U kunt in deze dialoog het type interpolatie kiezen, het interval
en het aantal punten voor de resulterende functie.

Hiervoor moet gsl zijn geinstalleerd (Gnu Scientific Library: Gnu wetenschappelijke bibliotheek).
Analyse->Differenties (Alt-d)
Openen van de dialoog voor differenties

Hier kunt een grafiek maken van de numerieke differenties van geselecteerde gegevens (afgeleide van
een functie).

Analyse->Integratie (Alt-n)
Openen van de dialoog voor integreren

Hier kunt de geselecteerde grafiek numeriek integreren. Definieer het interval dat u wilt of gebruik het
actieve interval (dit kan worden gedefinieerd in het menu Uiterlijk.)

Hiervoor moet gsl zijn geinstalleerd (Gnu Scientific Library: Gnu wetenschappelijke bibliotheek).
Analyse->Filter->Middelen (Alt-a)
Openen van de dialoog voor middelen

Hier kunt u een nieuwe grafiek maken van de (voor elke groep van n punten) gemiddelde gegevens
van elke andere grafiek.

Analyse->Filter->Gladstrijken (Alt-s)
Openen van de dialoog voor het gladstrijken van de gegevens

Hier kunt u een nieuwe grafiek maken van de (over elke groep van n punten) gladgestreken gegevens
van elke andere grafiek.

Analyse->Filter->Comprimeren (Ctrl-Shift-h)
Openen van de dialoog voor comprimeren

Comprimeren van gegevensverzamelingen.
Analys->Filter->Weglaten (Alt-r)
Openen van de dialoog voor het weglaten van gegevens

Hier kunt u een nieuwe grafiek maken van de gegevens van elke andere grafiek door elk n-de punt
weg te laten.

Analyse->Filter->Ruis (Alt-r)
Open van de dialoog voor ruis

Toevoegen van ruis aan uw gegevens.

Analyse->Filter->Signaalfilter (Alt-r)
Openen van de dialoog voor het filteren van het signaal
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Toepassen van een (signaal)filter op uw gegevens.
Analyse->Transformatie->FFT (Alt-f)
Openen van de FFT-dialoog (Fast Fourier Transform, snelle Fouriertransformatie)

Hier kunt een "Fast" (snelle methode) FourierTransformatie uitvoeren op de geselecteerde grafieken.
Indien dit op uw computer wordt ondersteund kunt u kiezen welke bibliotheek hiervoor wordt
gebruikt ("GNU scientific library (gsl)" of de "Fastest Fourier Transform in the West (fftw))". U kunt
zowel vooruit- als terug transformeren, langs de x-as de index, de frequentie of de periode laten
weergeven en langs de y-as de grootte, het reéle deel, het imaginaire deel of de fase.

Hiervoor moet gsl zijn geinstalleerd (Gnu Scientific Library: Gnu wetenschappelijke bibliotheek).
Analyse->Transformatie->Convolutie/Deconvolutie (Alt-C)
Openen van de convolutiedialoog

In deze dialoog kunt u een convolutie/deconvolutie uitvoeren van een grafiek met een andere. De
x-waarden die worden gebruikt kunt u selecteren.

Hiervoor moet gsl zijn geinstalleerd (Gnu Scientific Library: Gnu wetenschappelijke bibliotheek).
Analyse->Transformatie->Auto-/Kruiscorrelatie (Ctrl-+)
Openen van de correlatiedialoog

Uitvoeren van een auto-/kruiscorrelatie op een/twee grafieken.

Hiervoor moet gsl zijn geinstalleerd (Gnu Scientific Library: Gnu wetenschappelijke bibliotheek).
Analyse->Transformatie->Wavelet-transformatie (Ctrl-Shift-<)
Openen van de dialoog voor de Wavelet-transformatie

Hiervoor moet gsl zijn geinstalleerd (Gnu Scientific Library: Gnu wetenschappelijke bibliotheek).
Analyse->Transformatie->Hankel-transformatie (Ctrl-Shift->)
Openen van de dialoog voor de Hankel-transformatie

Hiervoor moet gsl >= 1.6 zijn geinstalleerd (Gnu Scientific Library: Gnu wetenschappelijke
bibliotheek).

Analyse->Statistiek->Geschiktheid (Alt-;)
Openen van de dialoog voor de geschiktheidsanalyse

Hiervoor moet gsl zijn geinstalleerd (Gnu Scientific Library: Gnu wetenschappelijke bibliotheek).
Analyse->Regressie (Alt-1)
Openen van de dialoog voor regressie

Hier kunt een regressie maken voor uw gegevens met verschillende soorten functies en gewichten.
Het interval voor de regressie kan hier ook worden opgegeven.

Hiervoor moet gsl zijn geinstalleerd (Gnu Scientific Library: Gnu wetenschappelijke bibliotheek).
Analyse->Niet-lineaire aanpassing (Alt-t)
Openen van een dialoog voor niet-lineaire aanpassing

In deze dialoog kunt u een niet-lineaire aanpassing maken voor uw gegevens. Thans kunnen 12
soorten functies worden geselecteerd, evenals elke zelfgedefinieerde functie met tot 9 parameters.
Beginwaarden, stapgroottes, en tolerantie kunnen worden ingesteld voor de niet-lineaire
kleinste-kwadraten aanpassing met gebruikmaking van gsl.
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Hiervoor moet gsl zijn geinstalleerd (Gnu Scientific Library: Gnu wetenschappelijke bibliotheek).
Analyse->Beeldbewerking (Ctrl-Shift-g)
Openen van de dialoog voor het bewerken van afbeeldingen

In deze dialoog kunt u matrix- of afbeeldingsgegevens als een afbeelding manipuleren. Bewerkingen
zoals roteren, schalen, scherper of helderder maken kunnen hierin worden gedaan. Zie ook het

overzicht van functies voor analyse.

Het menu Uiterlijk

Uiterlijk->Plots schikken (Alt-y)
Openen van de dialoog voor het rangschikken van de plots.

Hierin kunt u opgeven hoe de plots in een werkblad moeten worden gerangschikt.
Uiterlijk->Plots over elkaar (Ctrl--)
Openen van de dialoog voor het over elkaar leggen van plots.

Hier kunt u een plot precies op een andere leggen.
Uiterlijk->Plotinstellingen (Ctrl-j)
Openen van de plotdialoog.

Hier kunt u de instellingen wijzigen van de actieve plot.
Uiterlijk->Werkbladinstellingen (Alt-w)
Openen van de werkbladdialoog.

Hier kunt u de instellingen wijzigen van het actieve werkblad.
Uiterlijk->As -instellingen (Ctrl-b)
Openen van de dialoog voor de assen.

Hier kunt u de instellingen wijzigen van de assen in een plot.
Uiterlijk->Titeldialoog (Ctrl-t)
Openen van de titeldialoog.

Hier kunt u de instellingen wijzigen van de titel van een plot.
Uiterlijk->Legendadialoog (Ctrl-1)

Openen van de legendadialoog.

Hier kunt u de instellingen wijzigen van de legenda in een plot.
Uiterlijk->Tekenobjecten (Alt-o0)

Openen van de dialoog voor tekenobjecten.

Hier kunt u nieuwe tekenobjecten toevoegen en hun instellingen wijzigen.

Het menu Tekenen

In dit menu kunnen de basislijn en het plotgebied worden gedefinieerd. Ook kunnen 5 verschillende soorten
tekenobjecten hier eenvoudig worden aangemaakt.

Met "Basislijn aanmaken" kunt u een basislijn aanmaken die kan worden gebruikt bij het inkleuren van
grafieken en voor integratie. Met "Gebied aanmaken" kan een gebied worden gedefinieerd. Een gebied wordt
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gebruikt voor niet-lineaire aanpassing, integratie, enz.

Met de 5 overige menu-ingangen kunnen de verschillende tekenobjecten eenvoudig met de muis worden
aangemaakt. Volg hierbij de aanwijzingen in de statusbalk.

Het menu Bladen

Dit menu geeft u een lijst van alle werkbladen en rekenbladen van een project. U kunt hier kiezen welk blad
actief (en zichtbaar) is.

Het menu Grafieken

Dit menu geeft u een lijst van alle grafieken in een werkblad. U kunt hierin rechtstreeks de instellingen van
een grafiek wijzigen.

Het menu Scripts

In dit menu zijn die zaken verzameld die kunnen dienen voor het manipuleren van scripts waarmee
handelingen in LabPlot kunnen worden geautomatiseerd

Kijk in het Hoofdstuk Scripts maken voor het gebruik van de interface voor het maken van scripts in LabPlot

Scripts->Script inlezen (Ctrl-Shift-c)

Inlezen en uitvoeren van een Qt?-script voor toepassingen (QSA-script (*.gs)).
Scripts->QSA-werkbank openen (Ctrl-Shift-w)

Openen van de QSA-werkbank voor het maken en bewerken van QSA-scripts (*.gs).

Het menu Instellingen
In dit menu kunt u de gebruikersinstellingen wijzigen.

Instellingen->Volledig scherm (Ctrl-Shift-f)
Tonen van de werkruimte in een volledig scherm.
Instellingen->Menubalk Tonen (Ctrl-m)
Menubalk tonen aan/uit.
Instellingen->Labplot instellen
Instellen van de gebruikersinstellingen voor LabPlot. De standaard stijlen en symbolen voor 2d- en
oppervlakteplots kunnen hier ook worden ingesteld.
Instellingen->Instellingen opslaan
Opslaan van alle gebruikersinstellingen voor LabPlot.

Het menu Help

Help->Inhoud (F1)

U vindt hier de inhoudspagina van de hulp voor LabPlot.
Help->Voorbeelden

U vindt hier vele voorbeeldprojecten van LabPlot.
Help->Over LabPlot
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Geeft belangrijke informatie over LabPlot.

Hoofdwerkbalk

In de hoofdwerkbalk treft u veel aan dat u in de verschillende menu's kunt vinden. U kunt dit aanpassen in het
dialoogvenster in het menu Instellingen-> Werkbalken instellen

Gereedschapbalk aan de zijkant

De gereedschapsbalk van LabPlot aan de zijkant van het scherm heeft de volgende knoppen:

Knop Actie
Lens vergrootglas
Hand pennen zoomen
gegevensmodus afzonderlijke gegeven punten beschouwen.
gegevens maskeren gegeven punten selecteren voor maskeren.
X Autoschalen X.
Y Autoschalen Y.
Z Autoschalen Z.
+ Inzoomen.
- Uitzoomen.
Links Alle grafieken naar links schuiven.
Rechts Alle grafieken naar rechts schuiven.
Op Alle grafieken naar boven schuiven.
Neer Alle grafieken naar beneden schuiven.
X+ In X-richting vergroten.
X- In X-richting verkleinen.
Y+ In Y-richting vergroten.
Y- In Y-richting verkleinen.
7+ In Z-richting vergroten.
Z- In Z-richting verkleinen.

Chapter 5. De dialogen
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Uiterlijk
Plotinstellingen

Instellingen voor het werkblad
Assen

Titel
Legenda
Analyse
Schikken
Op elkaar
QSA-werkbank

Functie

In de dialoog Functie kunnen de plots voor functies worden aangemaakt en de instellingen ervan worden
gedaan. Voor 2d-, oppervlakte-, taart- en 3d-plots zien die er hetzelfde uit. Alleen een paar plot-specifieke
zaken zijn er anders. Vooral de Stijl is voor oppervlakte-plots anders.

Op de eerste invoerregel komt de expressie voor de te plotten functie. De ingevoerde expressie wordt gelezen
door een krachtige "parser” (programma dat de expressie inleest en herkent). Een complete lijst van de
beschikbare functies ziet u hier.

Op de tweede invoerregel kunt u de naam invullen van de gemaakte grafiek. Dit is de naam die u in de
legenda ziet.

In de afdelingen "Bereik" en "Aantal punten” kunt u het bereik selecteren en het aantal punten waarin en
waarvoor de functiewaarde wordt berekend.

Met de resterende stijlonderdelen kunt u het uiterlijk bepalen van de functie. Indien u een normale functie
aanmaakt definieert de eerste selectie het type lijn (Lijnen, GeenKromme, Stappen, Vakken, Pulsen,
Y-vakken), de kleur en of u die ingevuld wilt hebben (met een andere kleur). Met de andere onderdelen wordt
het symbool geselecteerd voor de punten in de plot, met kleur, grootte, of ze moeten worden ingevuld, en met
welke kleur. Bij het maken van een oppervlakteplot kunt u selecteren of u een dichtheids- of een contourplot
wenst, of beide. In dat geval kunt u het aantal niveaus kiezen voor contourplots en de kleurschaal voor
dichtheidsplots.

Om de instellingen van een functie te wijzigen moet u de knop voor wijzigen in de lijst-dialoog selecteren.
Om de stijl te wijzigen van een oppervlakteplot kunt u ook de dialoog "Plot-instellingen" gebruiken.

Vanaf de versie 1.4.0 wordt in LabPlot de nieuwe QWT 3d-plot gebruikt die de voorkeur heeft boven de
eenvoudige 3d-plot.

Gegevens

De dialoog Gegevens wordt gebruikt voor het maken van grafieken van gegevensbestanden.

Deze dialoog heeft veel weg van de functiedialoog. Toch zijn er enkele verschillen. In de eerste invoerregel
moet u een te openen gegevensbestand selecteren. U kunt de knop "Nieuw" gebruiken om hiervoor een
bestandsdialoog te openen. In de sectie "Lezen van kolom" kunt u selecteren van welke kolom u de waarden
wilt inlezen. Bij twijfel kunt u op de knop " Gegevens inzien" klikken om het gegevensbestand te kunnen
inzien. U kunt u hier ook instellen van welke tot welke rij gegevens moeten worden gelezen en welk
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scheidingsteken wordt gebruikt. De "auto"-separatie detecteert elk aantal en elke combinatie van de zg.
"whitespace"karakters (spatie, tab, nl, ff, crt. (nl is 'nieuwe regel', ff is 'nieuwe pagina', crt is 'wagen terug')).

Als bij "Lezen als" "y1 | y2 | y3|..." wordt geselecteerd dan worden de y-waarden gelezen op een enkele regel
in de gegevensbestanden.

In LabPlot wordt het inlezen van afbeeldingen ondersteund (alle door Qt? ondersteunde formaten) en ook van
gecomprimeerde gegevens (gzip, bzip2). Voor afbeeldingen moet u "matrix"selecteren om de gegevens
hiervoor in te lezen.

Vanaf versie 1.3.1 kan LabPlot ook netcdf-, cdf- en audio-gegevens (*.wav,*.au,*.aiff,*.snd,...) inlezen. Voor
netcdf en cdf kiest u gewoon de variabelen in de X, y, enz. invoerregels en mogelijk controleert u dit in de
dialoog "Gegevens inzien". Om de juiste variabelen op te zoeken kunt u de dialoog Bestandsinformatie
gebruiken, om de inhoud te bekijken van een netcdf/cdf-bestand. Bij het lezen van audiogegevens kiest u
eenvoudig 1 voor de tijd, 2 voor het eerste kanaal en 3 voor het tweede kanaal. 0 betekent natuurlijk de index,
zoals bij het lezen van elk ander gegevensbestand.

In de sectie "Lezen als" wordt het soort gegevens in het gegevensbestand geselecteerd. In "Type grafiek"
wordt het soort grafiek dat wordt aangemaakt gekozen. Van x-y-gegevens kunt u alleen 2-dimensionale plots
maken. Van x-y-z-gegevens kunt u fouten- en oppervlakteplots (2d-gegevensdialoog) of dichtheid-, contour-
en 3d-plots (3d-gegevensdialoog) maken. Van matrix-gegevens kunt u dichtheid- en contourplots
(2d-gegevensdialoog) of 3d-plots (3d-gegevensdialoog) maken.

Vanaf de versie 1.4.0 wordt in LabPlot de nieuwe QWT 3d-plot gebruikt die de voorkeur heeft boven de
eenvoudige 3d-plot.

Plotlijst

In de plotdialoog kunt u de plots in een werkblad hanteren. U kunt hierin plots dupliceren of wissen.

Grafiekenlijst

De lijstdialoog is het centrale punt voor het omgaan met de verschillende grafieken in een plot. Hierin krijgt u
een overzicht van alle grafieken en kunt u die manipuleren. U vindt deze lijstdialoog via het menu
Plotten->Grafiekenlijst of door te dubbelklikken in de plot. Alle genoemde functies kunnen in alle
lijstdialogen worden bereikt met de right mouse button

Met "Tonen/Verbergen"kunt u de toestand van alle geselecteerde grafieken afwisselen. Alleen "Getoonde"
grafieken zijn in de plot te zien. De autoschaal-functie werkt alleen voor de zichtbare grafieken.

Met de knoppen "Gegevensbestand toevoegen" en "Functie toevoegen" kunt u aan de plot een grafiek
toevoegen van gegevens of van een functie. (zie functiedialoog of gegevensdialoog. ) Met "Wissen" kunt u
eenvoudig de geselecteerde grafiek wissen. Met "Wijzigen" kunt u de instellingen wijzigen van de
geselecteerde grafiek. Als u alleen maar een kopie wilt hebben van een bestaande grafiek kiest u de knop
"Grafiek kopiéren".

Met de knop "Exporteren” wordt de dumpdialoog geopend voor het exporteren van een grafiek naar een
bestand en met de knop "Bewerken" komt u in de dialoog voor bewerken.
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Met "Maskeren aan/uit" en "Alles demaskeren" kunt u het maskeren van verschillende gegeven punten
wijzigen.

Met de knop "Statistieken" ziet u enkele statistieken met betrekking tot de geselecteerde grafieken.

Elke manipulatie kan ook worden bereikt via de rechter muisknop. Meervoudige selecties zijn mogelijk.

Grafiek toevoegen

Hier kunt u grafieken toevoegen van een ander werkblad of van elk rekenblad.

Importdialoog

Met de importdialoog kunt u in LabPlot gegevens importeren.

Op de invoerregel kunt u meerdere gegevensbestanden opgeven om in te lezen. Met de knop
"Bestandsinformatie" krijgt u informatie over de geselecteerde bestanden. U kunt ook het scheidingsteken

opgeven (bijvoorbeeld ",") en het karakter voor de commentaarregels. U kunt hier ook de eerste en laatste
rijen opgeven van de in te lezen gegevens.

Vanaf versie 1.4.1 van LabPlot kunt u een voorgedefinieerd filter selecteren voor verschillende standaard
gegevensformaten waarmee alle benodigde instellingen worden geselecteerd. In deze versie werd ook de
ondersteuning toegevoegd voor de import van binaire gegevens.

Bewerken

In de bewerkingsdialoog kunt u eenvoudig de gegevens van een grafiek bewerken. U kunt deze dialoog
vinden via de lijstdialoog.

In de tabel bovenaan ziet u alle gegevens. Hierin kunt u selecteren welke rijen en kolommen u wilt bewerken.
U kunt geselecteerde rijen wissen of ze in stijgende of dalende volgorde sorteren met behulp van de knoppen
onder de tabel. U kunt ook de expressie berekenen voor de geselecteerde rijen en kolommen. Hiervoor worden
de zelfde krachtige eigenschappen van de "parser" (inlees- en herkenningsprogramma voor functies) gebruikt

als in de functiedialoog.

Objecten

In de objectendialoog kunt u de instellingen wijzigen van alle tekenobjecten. De objectendialoog is te vinden
in het menu Uiterlijk.

Er zijn 5 tabbladen, een voor elk type tekenobject. Lijn, Tekst, Rechthoek, Ellips en Afbeelding. Van elk
objecttype kunt tot 10 verschillende objecten definiéren. Alle instellingen kunnen in deze dialoog worden
gewijzigd. Indien u een object wilt verwijderen selecteert u het object in de objectenlijst en klikt u op de knop
"object wissen".

Indien u objecten wilt aanmaken kunt u die in het menu Tekenen kiezen. De objecten kunnen daarna met de
muis worden verplaatst. Dubbelklikken op een object opent het ermee overeenkomende tabblad van de
objectendialoog.
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Informatie over bestanden

De dialoog voor informatie over bestanden kan worden gevonden via de gegevensdialoog. Hierin kunt u veel
informatie vinden over een gegevensbestand. In het bijzonder bij netcdf-, cdf- en audiobestanden kunt u de
inwendige structuur van een gegevensbestand bekijken.

Dumpen

De dumpdialoog kan worden bereikt via de dialoog voor de grafiekenlijst. Hierin kunt u een grafiek
exporteren naar een ASCII-, netcdf-, cdf-, audio-, binair of afbeeldingsbestand. Voor elk type bestand zijn er
speciale opties. U kunt ook het bereik opgeven voor de te exporteren gegevens.

In het geval van ASCII-gegevens wordt het bestand automatisch gecomprimeerd als aan de bestandsnaam de
extensie .gz of .bz2 wordt toegevoegd.

Uiterlijk

In de vier dialogen voor het uiterlijk kunt u de instellingen beinvloeden van de actieve plot. U kunt deze
dialogen bereiken via het menu "Uiterlijk" of door te dubbelklikken op het object in de plot.

Plotinstellingen

In de grafiekendialoog kunt u de achtergrondkleur selecteren, de achtergrondkleur van de grafiek (binnen de
plot) en de intervallen voor de diverse assen. Ook kunnen de instellingen worden gewijzigd voor merkteken
en basislijn. De functionaliteit auto-interval kan ook worden gevonden in de gereedschapsbalk aan de zijkant
van het scherm. Voor een eventueel oppervlakteplot kunt u hier ook de stijlinstellingen wijzigen.

Indien de actieve plot een QWT 3d-plot is kunt u hier enkele speciale instellingen selecteren. De plotstijl
verandert de oppervlakte van de 3d-"mesh" (maasstructuur). Met Codrdinatenstelsel stelt u de gewenste
codrdinaten in. De vloerstijl maakt contour- of dichtheidsplots op de vloer mogelijk met een door de gebruiker
opgegeven aantal iso-lijnen. Tenslotte kunt u een speciale kleurenkaart selecteren (139 verschillende
kleurenkaarten zijn standaard in LabPlot beschikbaar).

Instellingen voor het werkblad

Met de werkbladdialoog kunt u de titel van het werkblad wijzigen, en de z.g. "timestamp". U kunt titel en
tijdstipvermelding hier ook aan- of uitzetten.

Assen

In de dialoog voor de assen kunt u de instellingen wijzigen voor de verschillende assen. De dialoog wordt
geopend door op een van de assen te dubbelklikken.

In het bovenste gedeelte ziet u een lijst van alle assen. U kunt hierin de te wijzigen as kiezen. Om de as aan-

of uit te zetten gebruikt u het aankruisvakje bovenin de dialoog. Onder de assen ziet u verschillende tabbladen
voor de as-instellingen (kleur, schaalstreepjes, rooster, enz.).
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Titel

In de titeldialoog kunt u parameters van de titel wijzigen (naam, grootte en lettertype). De dialoog wordt
geopend door op de titel te dubbelklikken.

Legenda

In de dialoog voor de legenda kunt u de parameters voor de legenda veranderen (rand er om heen, grootte en
lettertype). De dialoog wordt geopend door op de legenda te dubbelklikken.

Analyse

Met de dialogen voor de analyse kunt u op verschillende manieren een grafiek analyseren. Door een ervan toe
te passen wordt een nieuwe grafiek aangemaakt in de actieve plot.

Alle functies voor de analyse laten u een bestemming selecteren voor de resulterende gegevens. U kunt het
resultaat toevoegen aan elk reeds bestaand of nieuw werkblad/rekenblad.

De meeste van de functies voor de analyse kunnen ook in een rekenblad worden gebruikt. Aan de hand van de
geselecteerde kolommen in het rekenblad wordt een nieuwe kolom met de resulterende waarden gevormd.

Table 5.1. Analyse-functies van LabPlot

Naam Beschrijving Parameters Toegepast op

Met minstens twee
grafieken in de actieve
plot kunt u in deze
dialoog met de erbij
Bewerkingen op behorende gegevens twee
gegevensverzameling bewerkingen uitvoeren. U |gegevensverzamelingen
kunt die hierin optellen,
aftrekken,
vermenigvuldigen en op
elkaar delen.

Met deze functie kunt u
gemiddelden berekenen
per n punten in de
grafiek. Het aantal punten
wordt hierdoor n keer zo
klein.

Middelen aantal te middelen punten [alles

Met deze functie kunt u
grote gegevensbestanden
comprimeren tot minder
punten. U kunt kiezen of |som of gemiddelde, aantal
elk vastgesteld aantal punten

punten moet worden
opgeteld of gemiddeld
(elke 3, elke 10, enz.).

Comprimeren alles
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Deze functie doet het
zelfde als middelen, maar
nu voor elk
gegevenspunt. U krijgt

REKENBLAD, X-Y,

gebruiken. Het aantal
punten wordt hierdoor n
keer zo klein.

punten

Gladstrijken aldus cen meer glad aantal punten X-Y-DY, X-Y-DX-DY,
- X-Y-DY-DY, X-Y-Z

verlopende grafiek met

een onveranderd aantal

gegeven punten.

Met deze functie wordt

het aantal gegeven punten

verkleind door alleen REKENBLAD, X-Y,
Weglaten maar elk n-de punt te aantal opeenvolgende X-Y-DY, X-Y-DX-DY,

X-Y-DY-DY

Periodieke functies

Met deze functie kan een
gegevensverzameling
worden verkleind door
alle gegevens tot een
periode van een functie te
reduceren. U kunt kiezen
tussen sommeren of
middelen.

som/gemiddelde, punten
per periode

REKENBLAD, X-Y,
X-Y-DY, X-Y-DX-DY,
X-Y-DY-DY

Per periode

Met deze functie wordt
het verschil (of de som)
berekend van een periode
vergeleken met de
volgende. De periode
wordt opgegeven door
het aantal punten dat zich
erin bevindt.

som/verschil, punten in een
periode

REKENBLAD, X-Y,
X-Y-DY, X-Y-DX-DY,
X-Y-DY-DY

Top bepalen

Met deze functie bepaalt
u de uiterste waarden van
een
gegevensverzameling. De
gevoeligheid van deze
bepaling wordt
vastgesteld met de
parameters
drempelwaarde en
nauwkeurigheid

uiterste waarden,
drempelwaarde
(Y-interval);
nauwkeurigheid
(X-interval)

X-Y, X-Y-DY,
X-Y-DX-DY, X-Y-DY-DY

Histogram

Met deze functie kunt u
een histogram maken van
een grafiek. Dat betekent
dat het y-interval in n
klassen wordt verdeeld en
dat elk gegevenspunt
binnen een klasse wordt
geteld.

gebruikte Y-interval, aantal
klassen

REKENBLAD, X-Y,
X-Y-DY, X-Y-DX-DY,
X-Y-DY-DY, MATRIX

Analyse

26



Het handboek van LabPlot

Interpolatie

Met interpoleren wordt
geprobeerd een vloeiende
kromme te vinden die
door een aantal gegeven
punten gaat. U kunt
diverse interpolaties
gebruiken, zoals lineair,
met een veelterm,
cspline, akima. Alle
gegeven punten in het
actieve interval worden
voor de interpolatie
gebruikt.

Interpolatietype,
interval/aantal punten voor
de interpolatiefunctie

REKENBLAD, X-Y,
X-Y-DY, X-Y-DX-DY,
X-Y-DY-DY

Differenties

In deze dialoog wordt bij
benadering de eerste
afgeleide functie bepaald
van een grafiek.

Geen

REKENBLAD, X-Y,
X-Y-DY, X-Y-DX-DY,
X-Y-DY-DY

Integratie

Deze functie kan worden
gebruikt voor de
numerieke integratie van
een grafiek. Met het
aankruisvakje "Voeg
grafiek toe" kunt u
selecteren of de
geintegreerde grafiek
moet worden toegevoegd.
Door het aankruisvakje
"Toon informatie" te
selecteren wordt de
cumulatieve som getoond
in een apart venster.

basislijn/integratie-interval,
som of oppervlakte
(absolute waarden)

REKENBLAD, X-Y,
X-Y-DY, X-Y-DX-DY,
X-Y-DY-DY

Regressie

Met regressie kan een
grafiek worden aangepast
aan een veelterm van tot
de 10-de graad.

gewicht/model, aantal
punten/interval voor
regressiefunctie

X-Y,X-Y-DY,X-Y-DX-DY

Fouriertransformatie

Hiermee kunt u de
Fouriertransformatie
berekenen van een
grafiek. In LabPlot kan
hiervoor de fftw of de
gsl- bibliotheek worden
gebruikt. U kunt kiezen
voor de voorwaartse of de
terug- (inverse)
transformatie.

X-waarden:
index/frequentie/periode;
Y-waarden:
grootte/fase/reéle
deel/imaginaire deel

X-Y, X-Y-DY,
X-Y-DX-DY, X-Y-DY-DY

Convolutie/Deconvolutie

Analyse

Met deze functie kan de
convolutie worden
berekend van deze
grafiek met een andere.

X-waarden: index/zelfde
als signaal

X-Y, X-Y-DY,
X-Y-DY-DY + X-Y,
X-Y-DY, X-Y-DY-DY
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In LabPlot wordt de FFT
van gsl hiervoor gebruikt.
Deconvolutie van een
verzameling is ook
mogelijk.

Niet-lineaire aanpassing

Met deze functie kunt u
een niet-lineaire
aanpassing maken aan
eengrafiek. U kunt uit 12
verschillende typen
aanpassingen kiezen of
een zelfgedefinieerde
functie gebruiken met tot
9 parameters. Merk op
dat vooral exponentiéle
functies erg gevoelig zijn
voor de beginwaarden.
De resulterende
aanpassingsparameters
worden in het onderste
veld getoond en
automatisch gebruikt als
beginwaarden voor een
verdere aanpassing. De
resultaten worden als
tekst aan de plot
toegevoegd.

aanpassingsfunctie,
beginwaarden,
basislijn/interval voor
aanpassing, bereik/aantal
punten voor de
aanpassingsfunctie

X-Y, X-Y-DY,
X-Y-DX-DY, X-Y-DY-DY

Bewerken van
afbeeldingen

Met deze functie kunt u
matrix- of
afbeeldingsgegevens van
de actieve plot
manipuleren (bijv. een
oppervlakteplot). In
LabPlot wordt de API
van ImageMagick
gebruikt om een
afbeelding te converteren
met ongeveer 50
verschillende methodes.

grootte (hoogte/breedte)
van resulterende afbeelding

MATRIX,AFBEELDING

Schikken

In de dialoog voor rangschikken kunt u opgeven hoe plots in een werkblad worden geplaatst. Met 2x2 worden
de plots geplaatst in een 2x2 schema met een bepaalde tussenruimte en binnen de randdikte van het werkblad.

Op elkaar

In de dialoog voor op elkaar leggen kunt u de ene plot eenvoudig boven op de andere plaatsen. Natuurlijk
moeten er dan wel minstens twee plots in het werkblad aanwezig zijn.

Schikken
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QSA-werkbank

In LabPlot wordt de "Qt? Script for Applications" (QSA: script voor toepassingen van Qt?) gebruikt voor het
maken van scripts. Voor het maken en bewerken van scripts heeft QSA de QSA-werkbank aan boord die ook
in LabPlot kan worden gebruikt. Als de werkbank klaagt dat sommige "pixmaps" (afbeeldingen die een
beschrijving bevatten voor elk beeldpunt) niet kunnen worden gevonden kunt u met de omgevingsvariabele
QSA_IMAGE_PATH het pad naar de gewenste pixmaps instellen. Ik zelf gebruik bijvoorbeeld "export
QSA_IMAGE_PATH=/sw/qsa-x11-free-1.1.2/src/ide/images/" voordat LabPlot wordt opgestart.

Voor meer informatie zie Hoofdstuk Scripts maken

Chapter 6. Gevorderde onderwerpen
Table of Contents

Onderwerpen
Foutbalken

TeX-tekst

Gegevensbank im-/exporteren

meervoudige plots

het gebruik van formaten voor datum en tijd
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U vindt hier wat uitleg over gevorderde onderwerpen.

Ik hoop dat dit u kan helpen enkele gevorderde onderdelen van LabPlot te gebruiken.

Onderwerpen

Foutbalken

Als u gegevens wilt plotten met foutbalken kunt u eenvoudig de gegevens invoeren in een rekenblad met de
importdialoog. Selecteer de kolommen X,Y en DX,DY die u voor de foutbalken wilt gebruiken. U moet dan
de hiermee overeenkomende plot selecteren (XYDY voor foutbalken in de Y-richting, XYDXDY voor
foutbalken in beide richtingen en XYDYDY voor 2 foutbalken (naar boven en naar beneden) in de
Y-richting).

Indien u de gegevensdialoog gebruikt om uw gegevens direct in een plot te importeren selecteert u het juiste
type (xly, xlyldy, xlyldxldy of xlyldy1ldy2) in de invoerregel "lezen als".

TeX-tekst

Vanaf versie 1.5.0 ondersteunt LabPlot het weergeven van Tex-tekst met behulp van texvc.

Indien u zelf LabPlot compileert hoeft er alleen een ocaml-compiler aanwezig te zijn. Bij gebruik van een
binaire versie van LabPlot wordt texvc automatisch gebruikt wanneer die in uw $SPATH aanwezig is.
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Om een TeX-tekst te gebruiken moet u slechts het aankruisvakje "TeX" aankruisen in de tekstdialoog. Dan
wordt elke tekst die u in het tekstvak invoert in Tex omgezet door texvc en aldus geplot. Omdat deze
omzetting enige tijd kost kan het opnieuw tekenen van de plot even duren.

Probeer het voorbeeld van "textekst" om een idee te krijgen hoe het eruit ziet.

Gegevensbank im-/exporteren

LabPlot ondersteunt lezen uit en schrijven van gegevens naar een gegevensbank, met behulp van de
KexiDB-bibliotheek. Met KexiDB kan LabPlot gegevens lezen uit en schrijven naar PostgreSQL, mySQL,
SQListe2+3. Om gegevens te importeren selecteert u "PostgreSQL, mySQL, enz." in de importdialoog en
bladert u door de structuur van de gegevensbank (tabellen en velden). Om gegevens te exporteren selecteert u
"GEGEVENSBANK" in de exportdialoog en selecteert u de gewenste parameter.

meervoudige plots

Vanaf versie 1.3.0 ondersteunt LabPlot meerdere plots in een werkblad. U kunt nieuwe plots eenvoudig
toevoegen aan een werkblad door "Nieuwe 2d-plot", "Nieuwe 3d-plot", enz. te kiezen. Een nieuwe plot wordt
automatisch geopend wanneer een functie- of gegevens-dialoog wordt geopend voor een een plot van een
ander type dan de actieve plot. Dus als bij een actieve 2d-plot "Nieuwe 3d-functie" wordt geselecteerd wordt
een nieuwe 3d-plot automatisch toegevoegd.

Met "Plots schikken" in het menu Uiterlijk kunt u eenvoudig plots in een werkblad rangschikken. Het schema
dat hierbij wordt gebruikt kan geselecteerd worden met getallen (zoals 2x2) en de afstand tussen de plots en
tussen de plots en de rand van het werkblad kan met de (tussen)ruimte worden ingesteld.

U kunt de plots ook handmatig in het werkblad plaatsen. Door de rand van een plot te slepen kunt u de plot
naar wens schalen. Als u de muis boven de randen van een plot houdt ziet u de hier bijbehorende pijltjes.

Een hele plot kan worden verplaatst met slepen en neerzetten door in het midden van de plot te klikken. Als u
het midden van de plot nadert ziet u een pijlenkruis.

het gebruik van formaten voor datum en tijd

Bij het lezen van gegevens in de gegevensdialoog kunt u niet alleen het formaat voor het lezen van een kolom
instellen op double (standaard, dubbele nauwkeurigheid), maar ook op dat van tijd en datum. In LabPlot wordt
de functie "fromString()" van Qt? gebruikt om de waarden in een kolom om te zetten naar een geldige datum
of tijd. Het hangt dus helemaal van die functie af welke datum- en tijdformaten goed zijn. Het lijkt erop dat
indien "datum" wordt geselecteerd dat het formaat van de kolom JJJJ-MM-DD moet zijn.

In de dialoog voor de assen kunt u drie verschillende formaten kiezen voor de tekst bij de schaalstreepjes:
datum, tijd en datumtijd. Met "datum" worden de geselecteerde waarden als dagen beschouwd sinds 1.1.1970.
Met "tijd" worden de geselecteerde waarden beschouwd als seconden. Met "datumtijd" tenslotte worden de
waarden beschouwd als seconden sinds 1.1.1970. U kunt het bij de streepjes getoonde formaat opgeven door
een bepaalde tekenreeks op te geven in de invoerregel voor het formaat.

Vanaf versie 1.4.0 kan LabPlot ook gegevens importeren in het datumtijd-formaat. Twee verschillende

formaten kunnen worden geselecteerd. Het tekst-formaat lijkt op de uitvoer van "datum" (lokatieathankelijke
wijzigingen zouden geen probleem moeten zijn) en het ISO-formaat "JJJJ-MM-DDTHH:MM:SS".
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QWT 3d-plots

Vanaf versie 1.4.0 gebruikt LabPlot de mooie bibliotheek qwtplot3d voor het maken van geraffineerde
3-dimensionale plots. Om redenen van compatibiliteit bestaat de eenvoudige 3d-plot nog steeds en die hebben
nog steeds enkele voordelen boven de 3d-plots van QWT. Maar ik raad u aan om wanneer dit mogelijk is de
QWT 3d-plot te gebruiken.

Voor de QWT 3d-plots wordt OpenGL gebruikt, u kunt dus de plots eenvoudig met de muis roteren, schalen
en verschuiven. In de dialoog voor de plotinstellingen (menu Uiterlijk) kunt u meer instellingen doen voor
deze 3-dimensionale plots.

Importeren van opj-bestanden van Origin

Omdat veel mensen het bekende programma Origin gebruiken van OriginLab, kan LabPlot opj-projecten van
Origin importeren, van versies 4.0 tot en met 7.5.

Omdat voor het opj-bestandsformaat eigendomsrechten gelden moest het importfilter worden ontwikkeld met
behulp van "reverse engineering" (uitvogelen hoe iets precies in elkaar steekt). Dit is de reden waarom het
veel werk kost om Origin-projecten te begrijpen en te converteren. In LabPlot 1.5.0 worden op dit moment
alleen de werkbladen van Origin ondersteund.

Indien er iemand is die hierover iets wilt vertellen en/of helpen zal ik doorgaan met de mogelijkheden van dit
filter verder uit te breiden.

XML-projectformaat

In LabPlot 1.5.1 wordt een nieuw projectformaat geintroduceerd op basis van XML. Na enkele toevoegingen
moet het in de toekomst voldoen aan de OASIS-standaard.

Het nieuwe XML-formaat ondersteunt achterwaartse en voorwaartse compatibiliteit en is veel schoner dan het
oude LPL-formaat. Dit formaat wordt in de toekomstige versies gebruikt als het standaard projectformaat en
het (vorige) LPL-formaat vervangen. Ook al zal LabPlot alle oude projecten zonder enige beperkingen kunnen
lezen.

Chapter 7. Inleesfuncties ("'parser")
Table of Contents

standaard functie

Speciale functie van GSL.

GSL willekeurige getalsverdelingen
constanten

GSI -constanten

De "parser" (programma voor het inlezen (in dit geval) en herkennen van expressies van functies) van
LabPlot; maakt het gebruik mogelijk van de volgende functies:
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Functie Beschrijving
acos(x) Arccosinus, inverse cosinus, boogcosinus
acosh(x) Hyperbolische arccosinus
asin(x) Arcsinus, inverse sinus, boogsinus
asinh(x) Hyperbolische arcsinus
atan(x) Arctangens, inverse tangens, boogtangens
atan2(y,x) Arctangens met twee variabelen
atanh(x) Hyperbolische arctangens
beta(a,b) Beta
cbrt(x) Derdemachts wortel
ceil(x) Afronden naar het eerstvolgende grotere gehele getal
chbevl(x, coef, N) Tsjebyshev- (Eng.: Chebyshev) reeks berekenen
chdtrc(df,x) Complement Chi-kwadraat
chdtr(df,x) Chi-kwadraat verdeling
chdtri(df,y) Inverse Chi-kwadraat
cos(x) Cosinus
cosh(x) Hyperbolische cosinus
cosm1(x) cos(x)-1
dawsn(x) Integraal van Dawson
drand() Willekeurig getal tussen O en 1
ellie(phi,m) Incomplete elliptische integraal (E)
ellik(phi,m) Incomplete elliptische integraal (E)
ellpe(x) Complete elliptische integraal (E)
ellpk(x) Complete elliptische integraal (K)
exp(x) Exponentiéle functie, grondtal e
expml(x) exp(x)-1
expn(n,x) Exponentiéle integraal
fabs(x) Absolute waarde
fac(i) Faculteit
fdtrc(ia,ib,x) Complement F
fdtr(ia,ib,x) F verdeling
fdtri(ia,ib,y) Inverse F verdeling
gdtr(a,b,x) Gamma verdeling
gdtrc(a,b,x) Complement gamma
hyp2fl(a,b,c,x) Gauss hypergeometrische functie
hyperg(a,b,x) Confluent hypergeometrisch 1F1
10(x) Gemodificeerde Bessel functie, orde 0
10e(x) 10 met exponenti€le schaal
11(x) Gemodificeerde Bessel functie, orde 1

standaard functie
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ile(x) il met exponentiele schaal

igamc(a,x) Complement gamma integraal

igam(a,x) Incomplete gamma integraal

igami(a,y0) Inverse gamma integraal

incbet(aa,bb,xx) Incomplete beta integraal

incbi(aa,bb,yy0) Inverse beta integraal

iv(v,Xx) Gemodificeerde Bessel functie, niet-gehele orde
jO(x) Bessel functie, orde 0

j1(x) Bessel functie, orde 1

jn(n,x) Bessel functie, orde n

jv(n,x) Bessel functie, niet-gehele orde

kO(x) Gemod. Bessel functie, 3de soort, orde 0
kOe(x) kO met exponenti€le schaal

k1(x) Gemod. Bessel functie, 3de soort, orde 1
kle(x) k1 met exponenti€le schaal

kn(nn,x) Gemod. Bessel functie, 3de soort, orde n
Ibeta(a,b) Natuurlijke log van Ibetal

Idexp(x,exp) vermenigvuldigen van decimaal getal met gehele macht van 2
log(x) Logaritme, grondtal e

log10(x) Logaritme, grondtal 10

logb(x) exponent, onafhankelijk van grondtal
loglp(x) log(1+x)

ndtr(x) Normale verdeling

ndtri(x) Inverse normale verdeling

pdtrc(k,m) Complement Poisson

pdtr(k,m) Poisson verdeling

pdtri(k,y) Inverse Poisson verdeling

pow(X,y) machtfunctie

psi(x) Psi- (digamma) functie

rand() Willekeurig getal tussen 0 en RAND_MAX
random() Willekeurig getal tussen 0 en RAND_MAX
rgamma(x) Omgekeerde Gamma

rint(x) afronden naar dichtstbijzijnde gehele getal
sin(x) Sinus

sinh(x) Hyperbolische sinus

spence(x) Dilogaritme

sqrt(x) Vierkantswortel

stdtr(k,t) Student's t-verdeling

stdtri(k,p) Inverse student's t-verdeling

struve(v,x) Struve functie

tan(x) Tangens

tanh(x) Hyperbolische tangens
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true_gamma(x) ware gamma

yO(x) Bessel functie, tweede soort, orde 0
y1(x) Bessel functie, tweede soort, orde 1
yn(n,x) Bessel functie, tweede soort, orde n
yv(V,X) Bessel functie, niet-gehele orde
zeta(x,y) Riemann Zeta functie

zetac(x) Zeta functie met twee argumenten

Speciale functie van GSL

Voor meer informatie over deze functies zie de documentatie van GSL:
http://www.gnu.org/software/gsl/manual/html_node/index.html. (Mede) om deze reden zijn een aantal
functiebeschrijvingen onvertaald gelaten zodat de documentatie per functie makkelijker is te vinden. Een

Nederlandstalige beschrijving van de gsl-bibliotheek heb ik helaas niet kunnen vinden (vertaler).

Functie Beschrijving
gsl_loglp(x) log(1+x)
gsl_expml1(x) exp(x)-1
gsl_hypot(x,y) sqre{x*2 + y"2}
gsl_acosh(x) arccosh(x)
gsl_asinh(x) arcsinh(x)
gsl_atanh(x) arctanh(x)
airy_Ai(x) Airy function Ai(x)
airy_Bi(x) Airy function Bi(x)

airy_Ais(x)

geschaalde versie van de Airy functie S_A(x) Ai(x)

airy_Bis(x)

geschaalde versie van de Airy functie S_B(x) Bi(x)

airy_Aid(x)

afgeleide van Airy functie Ai'(x)

airy_Bid(x)

afgeleide van Airy functie Bi'(x)

airy_Aids(x)

afgeleide van geschaalde Airy functie S_A(x) Ai(x)

airy_Bids(x)

afgeleide van de geschaalde Airy functie S_B(x) Bi(x)

airy_0_Ai(s)

s-de nulpunt van de Airy functie Ai(x)

airy_0_Bi(s)

s-de nulpunt van de Airy functie Bi(x)

airy_0_Aid(s)

s-de nulpunt van de afgeleide Airy functie Ai'(x)

airy_0_Bid(s)

s-de nulpunt van de afgeleide Airy functie Bi'(x)

bessel_JJO(x)

reguliere cilindrische nulde orde Bessel functie, J_0(x)

bessel_JJ1(x)

reguliere cilindrische eerste orde Bessel functie, J_1(x)

bessel_Jn(n,x)

reguliere cilindrische n-de orde Bessel functie, J_n(x)

bessel_YYO(x)

irreguliere cilindrische nulde orde Bessel functie, Y_0(x)

bessel_YY1(x)

irreguliere cilindrische eerste orde Bessel functie, Y_1(x)

bessel_Yn(n,x)

irreguliere cilindrische n-de orde Bessel functie, Y_n(x)

bessel_I0(x)

reguliere gemodificeerde cilindrische nulde orde Bessel functie, I_0(x)

bessel_I1(x)

reguliere gemodificeerde cilindrische eerste orde Bessel functie, I__1(x)

bessel_In(n,x)

reguliere gemodificeerde cilindrische n-de orde Bessel functie, I_n(x)
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bessel_ITI0s(x)

geschaalde reguliere gemodificeerde cilindrische nulde orde Bessel functie, exp
(-IxD) I_0(x)

bessel_II1s(x)

geschaalde reguliere gemodificeerde cilindrische eerste orde Bessel functie,
exp(-Ix) I_1(x)

bessel_Ins(n,x)

geschaalde reguliere gemodificeerde cilindrische n-de orde Bessel functie,
exp(-1xl) I_n(x)

bessel_KO0(x)

irreguliere gemodificeerde cilindrische nulde orde Bessel functie, K_0(x)

bessel_K1(x)

irreguliere gemodificeerde cilindrische eerste orde Bessel functie, K_1(x)

bessel_Kn(n,x)

irreguliere gemodificeerde cilindrische n-de orde Bessel functie, K_n(x)

bessel_KKOs(x)

geschaalde irreguliere gemodificeerde cilindrische nulde orde Bessel functie,
exp (x) K_0(x)

bessel_KK1s(x)

geschaalde irreguliere gemodifificeerde cilindrische eerste orde Bessel functie,
exp(x) K_1(x)

bessel_Kns(n,x)

geschaalde irreguliere gemodificeerde cilindrische n-de orde Bessel functie,
exp(x) K_n(x)

bessel_jO(x) reguliere sferische nulde orde Bessel functie, j_0(x)
bessel_jl1(x) reguliere sferische eerste orde Bessel functie, j_1(x)
bessel_j2(x) reguliere sferische tweede orde Bessel functie, j_2(x)
bessel_jl(1,x) reguliere sferische 1-de orde Bessel functie, j_I(x)

bessel_y0(x)

irreguliere sferische nulde orde Bessel functie, y_0(x)

bessel_y1(x)

irreguliere sferische eerste orde Bessel functie, y_1(x)

bessel_y2(x)

irreguliere sferische tweede orde Bessel functie, y_2(x)

bessel_yl(l,x)

irreguliere sferische 1-de orde Bessel functie, y_1(x)

bessel_i0s(x)

geschaalde reguliere gemodificeerde sferische nulde orde Bessel functie,
exp(-Ixl) i_0(x)

bessel_i1s(x)

geschaalde reguliere gemodificeerde sferische eerste orde Bessel functie,
exp(-Ixl) i_1(x)

bessel_i2s(x)

geschaalde reguliere gemodificeerde sferische tweede orde Bessel functie,
exp(-Ixl) i_2(x)

bessel_ils(1,x)

geschaalde reguliere gemodificeerde sferische I-de orde Bessel functie,
exp(-Ixl) i_I(x)

bessel_k0s(x)

geschaalde irreguliere gemodificeerde sferische nulde orde Bessel functie,
exp(x) k_0(x)

bessel_k1s(x)

geschaalde irreguliere gemodificeerde sferische eerste orde Bessel functie,
exp(x) k_1(x)

bessel_k2s(x)

geschaalde irreguliere gemodificeerde sferische tweede orde Bessel functie,
exp(x) k_2(x)

bessel_kls(1,x)

geschaalde irreguliere gemodificeerde sferische 1-de orde Bessel functie, exp(x)
k_1(x)

bessel_Jnu(nu,x)

reguliere cilindrische Besslfunctie van gebroken orde nu, J_\nu(x)

bessel_Ynu(nu,x)

irreguliere cilindrische Besselfunctie van gebroken orde nu, Y_\nu(x)

bessel_Inu(nu,x)

reguliere gewijzigde Besselfunctie van gebroken orde nu, I_\nu(x)

bessel_Inus(nu,x)

geschaalde reguliere gewijzigde Besslfunctie van gebroken orde nu, exp(-Ix|)
I_\nu(x)
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bessel_Knu(nu,x)

irreguliere gemodificeerde Besselfunctie van gebroken orde nu, K_\nu(x)

bessel_InKnu(nu,x)

logaritme van de irreguliere gemodificeerde Besselfunctie van gebroken orde
nu,In(K_\nu(x))

bessel_Knus(nu,x)

geschaalde irreguliere gemodificeerde Besselfunctie van gebroken orde nu,
exp(Ixl) K_\nu(x)

bessel_0_JO(s)

s-de positieve nulpunt van de Bessel functie J_0(x)

bessel_0_J1(s)

s-de positieve nulpunt van de Bessel functie J_1(x)

bessel_0_Jnu(nu,s)

s-de positieve nulpunt van de Bessel functie J_nu(x)

clausen(x)

Clausen integraal C1_2(x)

hydrogenicR_1(Z,R)

lowest-order normalized hydrogenic bound state radial wavefunction R_1 :=
27 \sqrt{Z} \exp(-Z r)

hydrogenicR(n,1,Z,R) n-th normalized hydrogenic bound state radial wavefunction

dawson(x) Integraal van Dawson

debye_1(x) eerste-orde Debye functie D_1(x) = (1/x) \int_0"x dt (t/(et - 1))
debye_2(x) tweede-orde Debye function D_2(x) = (2/x"2) \int_0"x dt (t"2/(e’t - 1))
debye_3(x) derde-orde Debye function D_3(x) = (3/x3) \int_0"x dt (t*3/(et - 1))
debye_4(x) vierde-orde Debye function D_4(x) = (4/x*4) \int_0"x dt (t"4/(e"t - 1))
dilog(x) dilogaritme

ellint_Kc(k)

complete elliptische integraal K(k)

ellint_Ec(k)

complete elliptische integraal E(k)

ellint_F(phi,k)

niet-complete elliptische integraal F(phi,k)

ellint_E(phi,k)

niet-complete elliptische integraal E(phi,k)

ellint_P(phi,k,n)

niet-complete elliptische integraal P(phi,k,n)

ellint_D(phi,k,n)

niet-complete elliptische integraal D(phi,k,n)

ellint_RC(x,y)

niet-complete elliptische integraal RC(x,y)

ellint_RD(x,y,z)

niet-complete elliptische integraal RD(x,y,z)

ellint_RF(x,y,z)

niet-complete elliptische integraal RF(X,y,z)

ellint_RJ(x,y,z)

niet-complete elliptische integraal RJ(X,y,z,p)

gsl_erf(x)

errorfunctie erf(x) = (2Asqrt(\pi)) \int_0"x dt \exp(-t"2)

gsl_erfe(x)

complementaire errorfunctie erfc(x) = 1 - erf(x) = (2Asqrt(\pi)) \int_x"infty
\exp(-t"2)

log_erfc(x)

logaritme van de complementaire errorfunctie \log(\erfc(x))

erf_7Z(x) Kansfunctie van Gauss Z(x) = (1/(2\pi)) \exp(-x"2/2)

erf_Q(x) bovenste staart van de kansfunctie van Gauss Q(x) = (1/(2\pi)) \int_x"\infty dt
- \exp(-t"2/2)

gsl_exp(x) exponentiéle functie

exprel(x) (exp(x)-1)/x met gebruik van een algoritme dat voor kleine waarden van x

nauwkeurig is

exprel_2(x)

2(exp(x)-1-x)/x"2 met gebruik van een algoritme dat voor kleine waarden van
X nauwkeurig is

exprel_n(n,x)

n-relatief exponentieel, dat de n-de generalisatie is van de functies
“gsl_sf_exprel'

exp_int_E1(x)

exponentiéle integraal E_1(x), E_1(x) := Re \int_1Minfty dt \exp(-xt)/t
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exp_int_E2(x)

tweede-orde exponentiéle integraal E_2(x), E_2(x) :=\Re \int_1MN\infty dt
\exp(-xt)/t"2

exp_int_FEi(x)

exponentiéle integraal E_i(x), Ei(x) := PV(\int_{-x}Minfty dt \exp(-t)/t)

shi(x)

Shi(x) = \int_07x dt sinh(t)/t

chi(x)

integraal Chi(x) := Re[ gamma_E + log(x) + \int_0"x dt (cosh[t]-1)/t]

expint_3(x)

exponentiéle integraal Fi_3(x) = \int_0"x dt exp(-t"3) voor x >=0

si(x) Sinus integraal Si(x) = \int_0"x dt sin(t)/t
ci(x) Cosinus integraal Ci(x) = -\int_xMinfty dt cos(t)/t voor x > 0
atanint(x) Arctangens integraal AtanInt(x) = \int_0”x dt arctan(t)/t

fermi_dirac_m1(x)

complete Fermi-Dirac integraal met een index van -1, F_{-1}(x) =e"x /(1 +
e”x)

fermi_dirac_0(x)

complete Fermi-Dirac integraal met een index van 0, F_0(x) =\In(1 + e"x)

fermi_dirac_1(x)

complete Fermi-Dirac integraal met een index van 1, F_1(x) = \int_0Minfty dt
(t /(\exp(t-x)+1))

fermi_dirac_2(x)

complete Fermi-Dirac integraal met een index van 2, F_2(x) = (1/2)
\int_0Minfty dt (t"2 /(\exp(t-x)+1))

fermi_dirac_int(j,x)

complete Fermi-Dirac integraal met een index van j, F_j(x) = (1/Gamma(j+1))
\int_0Minfty dt (tj /(exp(t-x)+1))

fermi_dirac_mhalf(x)

complete Fermi-Dirac integraal F_{-1/2}(x)

fermi_dirac_half(x)

complete Fermi-Dirac integraal F_{1/2}(x)

fermi_dirac_3half(x)

complete Fermi-Dirac integraal F_{3/2}(x)

fermi_dirac_inc_0(x,b)

incomplete Fermi-Dirac integraal met een index van 0, F_0(x,b) =\In(1 +
eMb-x}) - (b-x)

gamma(x) Gamma functie

Ingamma(x) logaritme van de Gamma functie

gammastar(x) regulated Gamma Function \Gamma”*(x) for x > 0

gammainv(x) omgekeerde van de gamma functie, 1/Gamma(x) met gebruik van de reéle

methode van Lanczos.

taylorcoeff(n,x)

Taylor coéfficient xn / n! voor x >=0

fact(n) faculteit n!

doublefact(n) dubbele faculteit n!! = n(n-2)(n-4)...

Infact(n) logaritme van n faculteit, log(n!)

Indoublefact(n) logaritme van de dubbele faculteit van n, log (n!!)

choose(n,m)

binomiaalcoéfficient 'kies m uit n zonder terugleggen'=n!/(m!(n-m)!)

Inchoose(n,m)

logaritme van 'kies m uit n zonder terugleggen'

poch(a,x) Pochhammer symbool (a)_x :=\Gamma(a + x)/\Gamma(x)
Inpoch(a,x) logaritme van het Pochhammer symbool (a)_x :=\Gamma(a + x)AGamma(x)
pochrel(a.x) relatief Pochhammer symbool ((a,x) - 1)/x waarin (a,x) = (a)_x :=\Gamma(a +

x)\Gamma(a)

gamma_inc_Q(a,x)

normalized incomplete Gamma Function P(a,x) = 1/Gamma(a) \int_x\infty dt
t*a-1} exp(-t) fora>0,x >=0

gamma_inc_P(a,x)

complementary normalized incomplete Gamma Function P(a,x) = 1/Gamma(a)
\int_0"x dt t*"{a-1} exp(-t) fora>0,x>=0
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gsl_beta(a,b)

Beta Functie, B(a,b) = Gamma(a) Gamma(b)/Gamma(a+b) voora>0,b >0

Inbeta(a,b)

logaritme van de Beta Functie, log(B(a,b)) voora>0,b >0

betainc(a,b,x)

genormaliseerde incomplete Beta functie B_x(a,b)/B(a,b) voora>0,b >0

gegenpoly_1(lambda,x)

Gegenbauer polynoom C*{lambda}_1(x)

gegenpoly_2(lambda,x)

Gegenbauer polynoom C*{lambda}_2(x)

gegenpoly_3(lambda,x)

Gegenbauer polynoom C*{lambda}_3(x)

gegenpoly_n(n,lambda,x)

Gegenbauer polynoom C*{lambda}_n(x)

hyperg_OF1(c,x)

hypergeometrische functie OF1(c,x)

hyperg_1F1i(m,n,x)

confluente hypergeometrische functie 1F1(m,n,x) = M(m,n,x) voor gehele
parameters m, n

hyperg_1F1(a,b,x)

confluente hypergeometrische functie 1F1(m,n,x) = M(m,n,x) voor algemene
parameters a,b

hyperg_Ui(m,n,x)

confluente hypergeometrische functie U(m,n,x) voor gehele parameters m,n

hyperg_U(a,b,x)

confluente hypergeometrische functie U(a,b,x)

hyperg_2F1(a,b,c,x)

Gauss' hypergeometrische functie 2F1(a,b,c,x)

hyperg_2F1c(ar,ai,c,x)

Gauss' hypergeometrische functie 2F1(a_R +ia_I,a_R-ia_l, ¢, x) met
complexe parameters

hyperg_2Fl1r(ar,ai,c,x)

renormalized Gauss hypergeometric function 2F1(a,b,c,x) / Gamma(c)

hyperg_2F1cr(ar,ai,c,x)

renormalized Gauss hypergeometric function 2F1(a_R +ia_I,a_R-ia_l, c, x)
/ Gamma(c)

hyperg_2F0(a,b,x)

hypergeometrische functie 2F0(a,b,x)

laguerre_1(a,x)

gegeneraliseerde Laguerre polynomen L a_1(x)

laguerre_2(a,x)

gegeneraliseerde Laguerre polynomen L a_2(x)

laguerre_3(a,x)

gegeneralisserde Laguerre polynomen L"a_3(x)

lambert_WO0(x)

hoofdtak van de Lambert W functie, W_0(x)

lambert_ Wm1(x)

tweede reéle tak van de Lambert W functie, W_{-1}(x)

legendre_P1(x)

Legendre polynomen P_1(x)

legendre_P2(x)

Legendre polynomen P_2(x)

legendre_P3(x)

Legendre polynomen P_3(x)

legendre_PI(1,x)

Legendre polynomen P_1(x)

legendre_QO(x)

Legendre polynomen Q_0(x)

legendre_Q1(x)

Legendre polynomen Q_1(x)

legendre_QI(1,x)

Legendre polynomen Q_I(x)

legendre_Plm(l,m,x)

associated Legendre polynomial P_1"m(x)

legendre_sphPIm(l,m,x)

normalized associated Legendre polynomial $\sqrt{(21+1)/(4\pi)}
\sqrt{(1-m)!/(1+m)!} P_1"m(x)$ suitable for use in spherical harmonics

conicalP_half(lambda,x)

irregular Spherical Conical Function PA{1/2}_{-1/2 + i \lambda}(x) for x > -1

conicalP_mbhalf(lambda,x)

regular Spherical Conical Function PA{-1/2}_{-1/2 + i \lambda }(x) for x > -1

conicalP_0(lambda,x)

conical function PA0_{-1/2 + i \lambda}(x) for x > -1

conicalP_1(lambda,x)

conical function PA1_{-1/2 + i \lambda}(x) for x > -1

conicalP_sphreg(l,lambda,x)

Regular Spherical Conical Function PA{-1/2-1}_{-1/2 + i \lambda}(x) for x >
-1, 1>=-1

conicalP_cylreg(l,lambda,x)
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Regular Cylindrical Conical Function PA{-m}_{-1/2 + i \lambda}(x) for x > -1,
m >= -1

legendre_H3d_0(lambda,eta)

zeroth radial eigenfunction of the Laplacian on the 3-dimensional hyperbolic
space, LAN{H3d}_0(lambda,eta) := sin(lambda eta)/(lambda sinh(eta)) for eta >=
0

legendre_H3d_1(lambda,eta)

zeroth radial eigenfunction of the Laplacian on the 3-dimensional hyperbolic
space, LAN{H3d}_1(lambda,eta) := 1/sqrt{lambda”2 + 1} sin(lambda
eta)/(lambda sinh(eta)) (coth(eta) - lambda cot(lambda eta)) for eta >= 0

legendre_H3d(l,lambda,eta)

L'th radial eigenfunction of the Laplacian on the 3-dimensional hyperbolic
space eta>=0,1>=0

gsl_log(x) logaritme van X
loga(x) logaritme van de absolute waarde van X, log(Ixl)
log(1 + x) voor x > -1 met behulp van een algoritme dat nauwkeurig is voor
logp(x) .
kleine waarden van x
logm(x) log(1 + x) - x voor x > -1 met behulp van een algoritme dat nauwkeurig is voor

kleine waarden van x

gsl_pow(x,n)

Machtsfunctie x*n voor gehele n

psii(n) digamma functie psi(n) voor positieve gehele n

psi(x) digamma function psi(x) voor alle x

psiy(y) recle deel van de digamma functie op de lijn 1+i y, Re[psi(l +1y)]
psli(n) Trigamma functie psi'(n) for voor positieve gehele n

ps_n(m,x) polygamma functie psi**{(m)}(x) voor m >=0, x >0

synchrotron_1(x)

eerste synchrotron functie x \int_x"infty dt K_{5/3}(t) voor x >=0

synchrotron_2(x)

tweede synchrotron functie x K_{2/3}(x) voor x >=0

transport_2(x)

transport functie J(2,x)

transport_3(x)

transport functie J(3,x)

transport_4(x)

transport functie J(4,x)

transport_5(x)

transport functie J(5,x)

hypot(x,y) hypotenusa functie \sqrt{x"2 + y"2}

sinc(x) sinc(x) = sin(pi x) / (pi X)

Insinh(x) log(sinh(x)) voor x > 0

Incosh(x) log(cosh(x))

zetai(n) Riemann Zeta functie zeta(n) voor gehele N

gsl_zeta(s)

Riemann Zeta functie zeta(s) voor alle s

hzeta(s,q) Hurwitz Zeta functie zeta(s,q) voor s > 1, q >0
etai(n) eta functie eta(n) voor gehele n
eta(s) eta functie eta(s) voor alle s

GSL willekeurige getalsverdelingen

Voor meer informatie over deze functies zie de documentatie van GSL:
http://www.gnu.org/software/gsl/manual/html_node/index.html. (Mede) om deze reden zijn een aantal
functiebeschrijvingen onvertaald gelaten zodat de documentatie per functie makkelijker is te vinden. Een
Nederlandstalige beschrijving van de gsl-bibliotheek heb ik helaas niet kunnen vinden (vertaler).
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Functie

Beschrijving

gaussian(Xx,sigma)

kansdichtheid p(x) in x voor een Gaussische (normale)
verdeling met standaarddeviatie sigma

ugaussian(x)

eenheids Gaussische verdeling. Equivalent met de
hierbovenstaande functies met een standaaarddeviatie een,
sigma=1

gaussian_tail(x,a,sigma)

kansdichtheid p(x) in x voor de (bovenste) staart van een
Gaussische verdeling met standaarddeviatie sigma en onderste
grens a

ugaussian_tail(x,a)

staart van een eenheids Gaussische verdeling. Equivalent met
de hierbovenstaande functies met een standaarddeviatie een,
sigma=1

bivariate_gaussian(X,y,sigma_x,sigma_y,rho)

kansdichtheid p(x,y) in (Xx,y) voor een Gaussische verdeling
met twee kansvariabelen met standaarddeviaties sigma_x,
sigma_y en correlatiecoéfficiént rho

exponential(x,mu)

kansdichtheid p(x) in x voor een exponentiéle verdeling met
gemiddelde mu

laplace(x,a)

kansdichtheid p(x) in x voor een Laplace verdeling met
gemiddelde a

exppow(x,a,b)

kansdichtheid p(x) in x voor een exponenti€le-macht verdeling
met schaalparameter a en exponent b

cauchy(x,a)

kansdichtheid p(x) in x voor een Cauchy verdeling met
schaalparameter a

rayleigh(x,sigma)

kansdichtheid p(x) in x voor een Rayleigh verdeling met
schaalparameter sigma

rayleigh_tail(x,a,sigma)

kansdichtheid p(x) in x voor de staart van een Rayleigh
verdeling met schaalparameter sigma en ondergrens a

landau(x)

kansdichtheid p(x) in x voor de Landau verdeling

gamma_pdf(x,a,b)

kansdichtheid p(x) in x voor een gamma verdeling met
parameters a en b

flat(x,a,b)

kansdichtheid p(x) in x voor een uniforme verdeling van a naar
b

lognormal(x,zeta,sigma)

kansdichtheid p(x) in x voor een lognormale verdeling met
parameters zeta en sigma

chisq(x,nu)

kansdichtheid p(x) in x voor een chi-kwadraat verdeling met
nu vrijheidsgraden

fdist(x,nul,nu2)

kansdichtheid p(x) in x voor een F-verdeling met nul en nu2
vrijheidsgraden

tdist(x,nu)

kansdichtheid p(x) in x voor een t-verdeling met nu
vrijheidsgraden

beta_pdf(x,a,b)

kansdichtheid p(x) in x voor een beta verdeling met parameters
aenb

logistic(x,a)

kansdichtheid p(x) in x voor een logistische verdeling met
schaalparameter a

pareto(x,a,b)

kansdichtheid p(x) in x voor een Pareto verdeling met
exponent a en schaal b

GSL willekeurige getalsverdelingen
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kansdichtheid p(x) in x voor een Weibull verdeling met schaal

weibull(x,2,b) a en exponent b

kansdichtheid p(x) in x voor een Type-1 Gumbel verdeling met
gumbell (x.2,b) parameters a en b
qumbel2(x.a,b) kansdichtheid p(x) in x voor een Type-2 Gumbel verdeling met

parameters aen b

poisson(k,mu)

kans p(k) op het verkrijgen van k in een Poisson verdeling met
gemiddelde mu

bernoulli(k,p)

kans p(k) op het verkrijgen van k in een Bernoulli verdeling
met kansparameter p

binomial(k,p,n)

kans p(k) op het verkrijgen van k in een binomiale verdeling
met parameters p en n

negative_binomial(k,p,n)

kans p(k) op het verkrijgen van k in een negatieve binomiale
verdeling met parameters p en n

pascal(k,p,n)

kans p(k) op het verkrijgen van k in een Pascal verdeling met
parameters p en n

geometric(k,p)

kans p(k) op het verkrijgen van k in een geometrische
verdeling met kansparameter p

hypergeometric(k,n1,n2,t)

kans p(k) op het verkrijgen van k in een hypergeometrische
verdeling met parameters nl, n2 en n3

kans p(k) op het verkrijgen van k in een logaritmische

logarithmic(k.p) verdeling met kansparameter p
constanten
Constante Beschrijving
PI1 1/pi
P12 2/pi
PISQRT?2 2/sqrt(pi)
E e
LN2 log_e 2
LN10 log_e 10
LOG2E log 2 e
LOGI10E log_10e
PI pi
PI_2 pi/2
PI_4 pi/4
SQRT2 sqrt(2)
SQRTI1_2 1/sqrt(2)
GSL-constanten

Voor meer informatie over deze constanten zie de documentatie van GSL:
http://www.gnu.org/software/gsl/manual/html_node/Physical-Constants.html.

Constante

Beschrijving

constanten
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c De lichtsnelheid in vacuum

mu0 De permeabiliteit van de vrije ruimte
e0 De permittiviteit van de vrije ruimte
Na Getal van Avogadro

F De molaire lading van 1 Faraday

k De Boltzmann constante

RO De molaire gas constante

VO Het standaard gasvolume

Gauss Het magnetisch veld van 1 Gauss

mu De lengte van 1 micron

ha De oppervlakte van 1 hectare

mph De snelheid van 1 mijl per uur

kmh De snelheid van 1 kilometer per uur
au De lengte van 1 astronomische eenheid (gemiddelde afstand zon-aarde)
G De gravitatieconstante

ly De lengte van 1 lichtjaar

pc De lengte van 1 parsec

g De standaard versnelling van de zwaartekracht op aarde
ms De massa van de zon

e De lading van het elektron

eV De energie van 1 elektronvolt

amu De atomaire massaeenheid

me De massa van het elektron

mmu De massa van het muon

mp De massa van de proton

mn De massa van de neutron

alpha De elektromagnetische fijnstructuurconstante
Ry De Rydbergconstante

a0 De straal van Bohr

A De lengte van 1 Angstrom

barn De oppervlakte van 1 barn

muB De Bohr magneton

muN De nucleaire magneton

mue Het magnetisch moment van het elektron
mup Het magnetisch moment van de proton
min Het aantal seconden in 1 minuut

h Het aantal seconden in 1 uur

d Het aantal seconden in 1 dag

week Het aantal seconden in 1 week

in De lengte van 1 inch (Engelse duim)
ft De lengte van 1 foot (Engelse voet)
yard De lengte van 1 yard

GSL-constanten
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mile De lengte van 1 mile (Engelse mijl)

mil De lengte van 1 mil (1/1000e van een inch)
nmile De lengte van 1 nautische mijl

fathom De lengte van 1 fathom (vadem)

knoop De snelheid van 1 knoop

pt De lengte van 1 punt voor afdrukkers (1/72 inch)
texpt De lengte van 1 TeX-punt (1/72,27 inch)
acre De oppervlakte van 1 acre

Itr Het volume van 1 liter

us_gallon Het volume van 1 US gallon

can_gallon Het volume van 1 Canadese gallon
uk_gallon Het volume van 1 UK gallon

quart Het volume van 1 quart

pint Het volume van 1 pint

pound De massa van 1 pound (Engelse pond)
ounce De massa van 1 ounce

ton De massa van 1 ton

mton De massa van 1 metrische ton (1000 kg)
uk_ton De massa van 1 UK ton

troy_ounce De massa van 1 troy ounce

carat De massa van 1 karaat

gram_force De kracht van 1 gram gewicht

pound_force

De kracht van 1 pound gewicht

kilepound_force

De kracht van 1 kilopound gewicht

poundal De kracht van 1 poundal

cal De energie van 1 calorie

btu De energie van 1 British Thermal Unit
therm De energie van 1 Therm

hp Het vermogen van 1 paardekracht

bar De druk van 1 bar

atm De druk van 1 standaard atmosfeer

torr De druk van 1 torr

mhg De druk van een kwikkolom van 1 meter
inhg De druk van een kwikkolom van 1 inch
inh20 De druk van een waterkolom van 1 inch
psi De druk van 1 pound per vierkante inch
poise De dynamische viscositeit van 1 poise
stokes De kinematische viscositeit van 1 stokes
stilb De luminantie van 1 stilb

lumen De lichtstroom van 1 lumen

lux De verlichtingssterkte van 1 lux

phot De verlichtingssterkte van 1 phot

GSL-constanten
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ftcandle De verlichtingssterkte van 1 footcandle

lambert De luminantie van 1 lambert

ftlambert De luminantie van 1 footlambert

curie De (radio)activiteit van 1 curie

roentgen De blootstelling (aan ioniserende straling) van 1 roentgen
rad De opgenomen dosis van 1 rad

De volgende constanten zijn hetzelfde in het cgs-stelsel :

Constante Beschrijving

c_cgs

G_cgs

h_cgs

hbar_cgs

mu0_cgs

au_cgs

ly_cgs

pc_cgs

g.cgs

eV_cgs

me_cgs

mmu_cgs

mp_cCgs

mn_cgs

Ry_cgs

k_cgs

muB_cgs

mulN_cgs

mue_cgs

mup_cgs

RO_cgs

VO0_cgs

in_cgs

ft_cgs

yard_cgs

mile_cgs

nile_cgs

fathom_cgs

mil_cgs

pt_cgs

texpt_cgs

mu_cgs

A_cgs

GSL-constanten
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ha_cgs

acre_cgs

barn_cgs

Itr_cgs

us_gallon-cgs

quart_cgs

pint_cgs

cup_cgs

fluid_ouncs_cgs

tablespoon_cgs

teaspoon_cgs

can_gallon_cgs

uk_gallon_cgs

mph_cgs

kmh_cgs

knot_cgs

pound_cgs

ouncs_cgs

ton_cgs

mton_cgs

uk_ton_cgs

troy_ounce_cgs

carat_cgs

amu_cgs

gram_cgs

pound_force_cgs

kilopound_force_cgs

poundal_cgs

cal_cgs

btu_cgs

therm_cgs

hp_cgs

bar_cgs

atm_cgs

torr_cgs

mhg_cgs

inhg_cgs

inh20_cgs

psi_cgs

poise_cgs

stokes_cgs

F_cgs

GSL-constanten

45




Het handboek van LabPlot

e_cgs

G_cgs

stilb_cgs

lumen_cgs

lux_cgs

phot_cgs

ftcandle_cgs

lambert_cgs

ftlambert_cgs

curie_cgs

roentgen_cgs

rad_cgs

sm_cgs

a0_cgs

e0_cgs

Chapter 8. Scripts maken

Table of Contents

QOSA
Scripts gebruiken
Bijzonderheden

In dit hoofdstuk wordt de interface in LabPlot uitgelegd voor het maken van scripts warmee u uw werk kunt
automatiseren. Door deze interface te gebruiken kunt u erg productief worden en uw werk vereenvoudigen als
u vaak dezelfde dingen doet. Met de kennis van deze interface kunt u LabPlot volledig op afstand besturen.

QSA

In LabPlot wordt de Qt? Script for Applications (QSA; script voor toepassingen) gebruikt van Trolltech, Inc.
Deze wordt met twee verschillende licenties uitgebracht - een commerciéle (dat nogal wat kost) en een onder
GPL (vrij om van het internet op te halen). De GPL-versie kent enkele beperkingen die van toepassing zijn in
het geval van commerci€el ontwikkelde toepassingen.

Natuurlijk moet LabPlot worden gecompileerd met ondersteuning voor QSA. Voor KDE 3 (gebaseerd op Qt?
3) is versie 1.1 X van QSA nodig.

Scripts gebruiken

Scripts zijn kleine bestanden met uit te voeren instructies. Omdat LabPlot met zulke scripts kan werken kan
het hiermee worden geautomatiseerd. Scripts kunnen met uw favoriete tekstverwerker worden gemaakt en
bewerkt of met de QSA-werkbank (kan in LabPlot worden gevonden in het menu " Scripts -> QSA
werkbank" . Indien de pictogrammen in de werkbank ontbreken, kijkt u dan even in het ‘Werkbankhoofdstuk.

Om een script uit te voern kunt u LabPlot script.gs aanroepen vanaf de opdrachtregel of een script op
het bureaublad in LabPlot slepen en neerzetten. U kunt ook de dialoog "Scripts->Script openen" in LabPlot
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gebruiken voor het uitvoeren van een script.

LabPlot is verdeeld in een aantal klassen ("classes" ). Hiervan hoeft u er maar een paar te kennen voor de
meeste scripts. Voor elke bewerking roept u slechts de overeenkomende functie aan in de klassen van
LabPlot. Alle beschikbare functies kunt u vinden in het klassenoverzicht op
http://cvs.sourceforge.net/viewcvs.py/*checkout*/labplot/doc/html/hierarchy.html.

Alle MainWin-functies kunnen direct worden aangeroepen. Laat ons beginnen met

importData ("sample.dat");

Hiermee wordt eenvoudig het gegevensbestand "sample.dat" in een rekenblad in LabPlot gelezen. Dit kunt u

zien in de schermafbeelding.

B Lab@iet 1.50.0e1 ¢ - LabPhot
fddEBoO R -3 S aEATAATO R AT AR

P

| + N X% B %

‘Webcome b LabPlot 15,11

Indien u nu met het rekenblad wilt gaan werken moet u de overeenkomende rekenbladfunctie aanroepen. Stel

we willen een 2d-plot maken

importData ("sample.dat");
s = activeSpreadsheet ();
s.plot2DSimple () ;

Het resultaat is

Scripts gebruiken
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We willen nu met de plot gaan werken. We moeten het werkblad hebben en hierin de actieve plot. De script
ziet er zo uit:

importData ("sample.dat");
= activeSpreadsheet ();
.plot2DSimple () ;

= activeWorksheet ();

= w.get2DPlot (w.API());
.setBackground ("green") ;
.redraw () ;

500 = non

met als resultaat dat we een groene achtergrond hebben

Ede  Edt wiew Speeadih Anak A Orawng Sheetlnt Graphlst Sgept  Sepngi  lelp
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Wiehoome o LabPiok 15.1.rc1

Een complete script die gegevens importeert en enkele instellingen wijzigt voordat het resultaat wordt
opgeslagen als EPS kan er als volgt uitzien:

importData ("sample—-data/sin.dat");

s = activeSpreadsheet () ;

Scripts gebruiken
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s.plot2DSimple () ;

w = activeWorksheet ();
w.get2DPlot (w.API());

e}
Il

p.setBackground ("green") ;
.setGraphBackground ("lightblue");

e}

= p.ActRange (0);
.setRange (250, 750) ;
= p.ActRange (1) ;
.setRange (-2, 2);

KRR B

=

= p.getlLegend() ;
l.setPosition (.5, .4);

t = p.Title();
t.setTitle ("example title");
t.setRotation (10);

a = p.getAxis(0);
a.enableMajorGrid() ;

11 = a.getLabel();

1ll.setTitle ("different x axis");
font = new Font ("SanSerif");
a.setTickLabelFont (font);

p.setMarksEnabled();
mark = p.markX();

mark.setRange (450, 550) ;

p.setRegionEnabled () ;
p.setRegion (350,650);

// w.redraw () ;

exportEPS ("export.eps");
exit ();

De gebruikte functies zouden duidelijk moeten zijn (helaas iets minder voor iemand zonder wat kennis van het

Engels (vert.)). De resulterende EPS ziet er dan uit als

Scripts gebruiken

49



Het handboek van LabPlot

Dit is eigenlijk alles dat u moet weten over het schrijven van scripts. Meer voorbeelden kunnen worden
gevonden in de map examples/scripts/ van de bronbestanden of in de map met gegevens van LabPlot.

Bijzonderheden

Kijk in de QSA-documentatie voor een gedetailleerde beschrijving van de syntaxis van QSA. Alle
opsommingen die in LabPlot beschikbaar zijn kunt u ook in scripts gebruiken. Zie ook de globale script
labplot.gs.

Met QSA is het ook mogelijk dialogen te gebruiken voor het invoeren van bestandsnamen, enz. In het
volgende voorbeeld wordt een dialoog gebruikt voor het invoeren van een naam voor een gegevensbestand:

d = new ImportDialog();
var filename = FileDialog.getOpenFileName( "*.dat" );
if (filename) ({

d.setFilename (filename) ;
d.Apply () ;

Chapter 9. Voorbeelden

In dit hoofdstuk vindt u een uitleg van de voorbeeldprojecten van LabPlot. U kunt alle voorbeelden vinden
onder Help->Voorbeelden behalve wanneer vermeld

Table 9.1. Voorbeeldprojecten voor LabPlot

Schermbeeld Naam Beschrijving
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tekst bij assen

dit voorbeeld laat u zien hoe u verschillende teksten
bij de assen kunt gebruiken. De getoonde functie is tot
de basislijn ingevuld.

dit voorbeeld toont Rydberg spectra gemeten met

log as-schaal

rydberg spectra foto-excitatie van metastabiele helium in een
magneto-optische val.
T
Lol B bt o ) el i o ) o el ) W B L

in dit voorbeeld worden logaritmische schalen
gebruikt voor de assen met een aangepaste tekst bij de
schaalstreepjes
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audio-gegevens

dit voorbeeld laat gegevens zien van gegevens
gelezen uit een audio-bestand
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merkteken

dit voorbeeld laat zien hoe een merkteken kan worden
gebruikt

Chapter 9. Voorbeelden
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: =  |TeX-tekst in dit voorbeeld wordt een TeX-tekst gebruikt
_I_-"_-I - — -
P
st Bt 0 ] e o G ) w2
:: simple dara amakyis
I et in dit voorbeeld wordt het verschil getoond tussen de
/1. drie analyse-functies weglaten, middelen en
- ¥, R analyse .. . . ..
- = = gladstrijken. U ziet hier verschillende stijlen en
| "y symbolen voor het tonen van gegevens.
(i 57 S e P O DT
Lot B 0 ] e o s ) S e
= irmgie 11 anabrb
I T
& =
: i it ., . dit voorbeeld laat zien hoe een eenvoudige
- [ —r I " 1|leenvoudige fft . . . .
| - it = Fouriertransformatie eruit kan zien.
Ml _

histogram

dit voorbeeld laat een voorbeeldhistogram zien van
een periodieke functie.

niet-lineaire
aanpassing

dit voorbeeld toont een niet-lineaire
Lorentz-aanpassing van een gegevensverzameling van
monsters in een opgegeven interval.
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exponentiéle in dit voorbeeld ziet u hoe een exponentiéle
aanpassing aanpassing van gegevens eruit moet zien.
SAG NS . v WA AT WA DM O
v
E |1 —
v . dit voorbeeld laat een exponenti€le aanpassing zien in
E P log aanpassing o
+ een logaritmische plot.
T e A IO
H - in dit voorbeeld ziet u een eenvoudige
] oppervlakteplot met een dichtheids- en
] . .
g oppervlakte contourdiagram van een door de gebruiker
% gedefinieerde functie. Het kleurenpalet is gekozen om
< de functiewaarden mooi uit te laten komen.
P 1 T P P PR T
: - E
A Ny : . .. dit voorbeeld laat de zelfde gegevensverzameling zien
E oppervlaktestijl . . ..
+ CEEN 'I als oppervlakteplot in verschillende stijlen.
E : g,,l .,::,H,I (= R -
Hla-\-..'?-:-\l.' i
3d dit voorbeeld toont een eenvoudige 3-dimensionale
plot van een functie.
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f ~, ® : - . in dit voorbeeld ziet u hoe u in LabPlot tekenobjecten
W | “, |||tekenobjecten .
- - e kunt gebruiken.
-
g
g . dit voorbeeld laat een oppervlakteplot zien gemaakt
§ afbeeldingen . pp p £
2 van een afbeeldingsbestand (utm.xpm).
g
1]
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. dit voorbeeld laat een eenvoudig taartdiagram zien
taartdiagram . .
van tweedimensionale gegevens
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qn
3 . :
: »
o 3 d Al in dit voorbeeld ziet u hoe u de balkstijl kunt
B d : balkplot . .
+ P et gebruiken voor x- en y-intervallen.
E : A
:uuumm‘-:m’:q::ﬂwh?:: | Eel R B T ﬂ‘
é :'J '1 dit voorbeeld toont het gebruik van meerdere plots in
g een werkblad. Hier ziet u vier verschillende typen van
g meerdere plots . .
2 - | plots 2x2 gerangschikt met een onderlinge
g ,‘?-h,‘, ,/ | e . tussenruimte van 0,05.

Chapter 9. Voorbeelden

54




Het handboek van LabPlot

[ LA LT —— T TR e
i B g smnr Gy i o B
~maEsta L] EA T I

1 [ P

e LR L T

gwt 3d-plot

dit voorbeeld toont het gebruik van een qwt
3-dimensionale plot. In dit voorbeeld wordt een
aangepaste kleurenkaart gebruikt en de "vloeriso"-stijl
voor contourlijnen op de vloer.

P L £ e g D Bt L e —t

A o o B e 1 O T T
- errury Flot

EEDMEOEEEEEER % e~
1 iy
! H
= »
g W ¢
»

ternair diagram

T T Pt [ SEREN ELFS SN HET R Ee P Sar (i
.
3
g oo een dit is nog een voorbeeld van een oppervlakteplot.
] .« . . . . .
g o gervlakte lot Hierin kunt u zien dat ook hier een logaritmische
E _ PP P as-verdeling kan worden gebruikt.
1]
i G e e smmpe ey S o L
I D] R ST N O R T N
- Potar ot
o - s
¢ st i
: ( )
Al W . dit voorbeeld laat een eenvoudig pooldiagram zien
o} [l i+ [pooldiagram .
< van functies
i G e e smmpe ey S o L

in dit voorbeeld ziet u een ternair diagram van wat
gegevens
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sfi (alleen op de
download-pagina)

in dit voorbeeld maakt u kennis met plots die op
elkaar zijn geplaatst door het laten zien van een
spectrum van selectieve veldionisatie met daar boven
op een diagram van de helling van het veld.
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Bekende fouten (bugs)

Bekende fouten (bugs)

U vindt hier een lijst van de bekende fouten. Een meer uitgebreide lijst vindt u in het TODO-bestand in het
LabPlot-pakket.

1. pstoedit werkt niet altijd goed.

2. Met SuSE 9.0 "crash"t LabPlot bij het opstarten.

3. ImageMagick kan niet worden gebruikt op FreeBSD 4-stable.

4. Bij gebruik van het KPart-object in LabPlot kan de grootte van het venster niet worden gewijzigd.

1. pstoedit werkt niet altijd goed.

pstoedit heeft soms een probleem met het omzetten (converteren) van postscript-bestanden die door Qt?
zijn gemaakt. Vooral wanneer "truetype"-lettertekens worden gebruikt lijkt het erop dat Qt? beschadigde
postscript-bestanden maakt. Met ghostscript lijken deze postscript-bestanden goed te zijn maar met
pstoedit kunnen ze niet worden omgezet.

Ik heb voor dit probleem geen oplossing gevonden en heb tenslotte de standaard lettertekens van LabPlot
gewijzigd om alleen die te gebruiken die met pstoedit geen problemen veroorzaken. Ik hoop dat in een
toekomstige versie van Qt? dit wordt verholpen.

2. Met SuSE 9.0 "crash"t LabPlot bij het opstarten.

Het originele Qt?-pakket van SuSE 9.0 heeft een fout bij het roteren van tekst. Alle toepassingen die deze
bibliotheek gebruiken om tekst te roteren zullen dus "crash"en. SuSE stelt op hun webpagina een
vernieuwd Qt?-pakket voor SuSE 9.0 beschikbaar. Dus vernieuwt u alstublieft het Qt?-pakket.

Ongelukkigerwijs is er nog steeds een fout in de tekstrotatie door Qt? op SuSE 9.0, waardoor de
alleenstaande letters in een tekenrij niet worden geroteerd. Om dit te herstellen moet u naar SuSE 9.1
vernieuwen, waar de Qt?-tekstrotatie perfect werkt.

3. ImageMagick kan niet worden gebruikt op FreeBSD 4-stable.

Wanneer u LabPlot compileert op FreeBSD 4-stable met ImageMagick schijnt er een probleem te zijn dat
zich alleen voordoet op FreeBSD 4 :

/ust/include/sys/cdefs.h:273: warning: =_POSIX_C_SOURCE!' is not defined (een waarschuwing dat
*_POSIX_C_SOURCE  niet is gedefinieerd)

Ik heb er geen idee van wat dit probleem veroorzaakt. Als iemand dit kan oplossen wil ik graag dat hij/zij
mij een berichtje stuurt. Op dit moment is het enige dat kan worden gedaan het deactiveren van
ImageMagick (--disable-ImageMagick) bij het compileren.

4. Bij gebruik van het KPart-object in LabPlot kan de grootte van het venster niet worden gewijzigd.

Bij het veranderen van de grootte van het venster naar de gewenste grootte moet u de pagina met KPart
opnieuw inlezen. Dit moet deze fout ongedaan maken.
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Chapter 11. Vragen en Antwoorden

11.1. Yoor welke platformen (computersystemen) is I.abPlot beschikbaar?

11.2. Na het compileren en starten van LabPlot zie ik alleen een "Bestand" en "Help" menu. De werkbalken
zijn geheel leeg. Wat is er mis?

11.3. Hoe exporteer ik een actief werkblad als een afbeelding?

11.4. Sommige functies voor de analyse werken niet. Wat kan ik doen?

11.5. Hoe kan ik Griekse letters gebruiken in titel. tekst bij de assen enz.?

11.6. Hoe kan ik de objecten. plots enz. van LabPlot in mijn eigen toepassing gebruiken?

11.7. Ik mis een belangrijke eigenschap. Wat kan ik doen?

11.8. Ik wil helpen. Kan ik aan LabPlot bijdragen?

11.1. Voor welke platformen (computersystemen) is LabPlot beschikbaar?

LabPlot is ontwikkeld voor Unix-platformen en heeft de Qt?-toolkit (gereedschapskist) en KDEnodig.
Normaal kunt u LabPlot compileren en gebruiken op elk platform dat door KDE (>=3) wordt
ondersteund. Een recente lijst met ondersteunde platformen en tips voor het compileren en het laten
werken van LabPlot vindt u op _http://labplot.sf.net/wiki?Download.

Persoonlijk heb ik toegang tot en kan ik de volgende platformen ondersteunen:

® SuSE 10.0 (main development platform)
* SuSE 9.3

* SuSE 9.1

® Fedora Core 4

® Fedora Core 3

® RedHat 9

e Mandriva 2006

® Mandrake 10.1

e Mandrake 10.0

e Slackware 10

. Met behulp van wat vrijwilligers is van de volgende platformen ook bekend dat LabPlot daarop draait:

® Debian 3.0

e FreeBSD 4,5
e PLD 2.0

e CentOS 4

Als u LabPlot wilt compileren en testen op een ander platform (zoals Solaris, Xantos, Windows, enz.),
laat me dit dan weten. Als u tijdens het compileren enig probleem tegenkomt kan ik misschien helpen.

11.2. Na het compileren en starten van LabPlot zie ik alleen een "Bestand" en "Help" menu. De werkbalken
zijn geheel leeg. Wat is er mis?

In LabPlot wordt de standaard manier gebruikt voor het aanmaken van de grafische gebruikersinterface
(GUI) van KDE-toepassingen. De GUI van LabPlot wordt beschreven in het bestand "LabPlotui.rc" dat
in het juiste KDE-pad moet worden geinstalleerd opdat KDE het menu en de werkbalken, enz kan
opbouwen. In een normale KDE-installatie moet met "./configure --prefix=$KDEDIR ; make ; make
install" alle bestanden in de juiste mappen worden geplaatst (bijv. SKDEDIR/share/apps/LabPlot/ voor
"LabPlotui.rc"). Kijk alstublieft bij uw distributie waar de benodigde bestanden moeten worden
geinstalleerd.
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Het is ook mogelijk om voor de "shared files" (gedeelde bestanden) die voor KDE worden gebruikt zelf
een map aan te wijzen. Deze map moet worden opgegeven in de omgevingsvariabele KDEDIRS. Dus
wanneer u LabPlot installeert in /usr/local moet u "/usr/local" toevoegen aan de omgevingsvariabele
KDEDIRS voordat u KDE start.

11.3. Hoe exporteer ik een actief werkblad als een afbeelding?

Er zijn drie manieren waarop u een actief werkblad kunt exporteren naar een afbeelding. De standaard
manier is met "Bestand->Exporteren naar afbeelding”. Hierbij zijn alle door Qt? ondersteunde
afbeeldingsformaten mogelijk. Selecteer het gewenste afbeeldingsformaat waarna het actieve werkblad
wordt geéxporteerd. De tweede manier om naar een afbeelding te exporteren is met
"Bestand->Exporteren via pstoedit". Hierdoor wordt het actieve werkblad ge€xporteerd naar Postscript
en daarna intern omgezet naar het geselecteerde formaat via pstoedit. Een groot aantal niet-afbeeldings
formaten (zoals PDF of DXF) worden ook ondersteund. U kunt de grootte van de afbeelding, de schaal
en de rotatie in deze dialoog selecteren. De derde manier naar een afbeelding te exporteren is met
"Bestand->Exporteren via ImageMagick". In LabPlot wordt de bibliotheek van ImageMagick gebruikt
voor de conversie naar alle mogelijke afbeeldingsformaten (ImageMagick ondersteunt meer dan 200
formaten). Zoals bij "Exporteren via pstoedit” kunt u de grootte, de schaal en de rotatie van de
afbeelding selecteren.

11.4. Sommige functies voor de analyse werken niet. Wat kan ik doen?

In LabPlot wordt gebruik gemaakt van de GNU Scientific Library (gsl: GNU wetenschappelijke
bibliotheek) voor regressie, Fouriertransformatie en niet-lineaire aanpassing (curve fit). U kunt LabPlot
ook gebruiken als gsl niet is geinstalleerd, maar dan kunt u de bovengenoemde functies niet gebruiken.
Dus als deze eigenschappen nodig zijn moet u wel de gsl installeren.

11.5. Hoe kan ik Griekse letters gebruiken in titel, tekst bij de assen enz.?

In Labplot wordt het lettertype " greek times" gebruikt dat in SuSE beschikbaar was tot versie 9.0. Wilt
u dit lettertype kunnen gebruiken dan moet u nog het pakket xfntgreek-1.0-560.noarch.rpm installeren.

Als alles werkt moet u de Griekse letters (kleine en grote) kunnen zien in de Tekstdialoog en ze in een

tekst kunnen gebruiken.

11.6. Hoe kan ik de objecten, plots enz. van LabPlot in mijn eigen toepassing gebruiken?

Vanaf versie 1.2.3 van LabPlot zijn alle klassen ("classes") van LabPlot verzameld in de bibliotheek
libLabPlot. Op dit moment moet u in de pakketten met de broncode kijken voor de documentatie van
alle klassen. Na uitproberen hoe deze bibliotheek kan worden gebruikt zal ik de documentatie van de
API (application programming interface: interface voor het programmeren van toepassingen) van de
bibliotheek verbeteren met behulp van (de toepassing) doxygen. Ik ontvang graag een email indien er
vragen zijn. Bovendien heb ik een KPart-object gemaakt voor LabPlot-projecten zodat u een *1pl
bestand van LabPlot kunt bekijken en bewerken in uw toepassing. Bekijk alstublieft de documentatie
van KDE hoe de KPart-objecten van KDE kunnen worden gebruikt.

11.7. Ik mis een belangrijke eigenschap. Wat kan ik doen?

Kijk in het TODO-bestand in de documentatie van LabPlot. Hier staan alle geplande eigenschappen
min of meer gesorteerd die ik zal toevoegen aan toekomstige versies van LabPlot. Als u nog andere
eigenschappen wenst of als u spoedig over een eigenschap in de lijst wilt kunnen beschikken, kunt u
mij een email sturen met uw wensen en, indien mogelijk, voorbeeld-gegevens of een korte beschrijving
van wat u wenst te doen. Het is dan niet onwaarschijnlijk dat uw eigenschap in de volgende stabiele
versie van LabPlot aanwezig zal zijn :-)

11.8. Ik wil helpen. Kan ik aan LabPlot bijdragen?

Ja, natuurlijk. Er is heel wat te doen. Ook als u niets weet van programmeren zijn er altijd mensen
nodig voor het vinden van fouten, dingen uitproberen en het doen van suggesties. Ook de vertaling en
de documentatie geeft heel veel werk. Stuur me maar een email als u wilt helpen.
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LabPlot
Programma copyright 2006 Stefan Gerlach <gerlach@mbi-berlin.de>

Vergeet niet: LabPlot is nog in ontwikkeling. Er is nog een lange lijst van eigenschappen die nog ontbreken,
die aan latere versies van LabPlot zullen worden toegevoegd.

Omdat er nog heel veel is te doen kan ik alle hulp gebruiken die ik maar kan krijgen. Elke bijdrage zoals
wensen, verbeteringen, programmaverbeteringen, foutmeldingen of schermafbeeldingen is welkom.

Documentatie copyright 2006 Stefan Gerlach <gerlach@mbi-berlin.de>
This documentation is licensed under the terms of the GNU Free Documentation License.

This program is licensed under the terms of the GNU General Public License.

Appendix A. Installeren
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Compileren en installeren

Het verkrijgen van LabPlot

LabPlot kan worden gevonden op de thuispagina op sourceforge.net: http://labplot.sf.net. Er is een overzicht
van alle beschikbare pakketten op http://labplot.sf.net/wiki?Download.

Vereisten

Om LabPlot goed te kunnen gebruiken is minstens een standaard installatie nodig van KDE 3.0.
In LabPlot worden de volgende bibliotheken meegeleverd:

® Cephes Math Library Release 2.3: June, 1995 : aanpassing van Grace voor het gebruik van krachtige
wiskundige functies (parser) [Free]

e gwtplot3d 0.2.4beta : geeft OpenGL 3d-plots. Gebruikt in QWT 3D-plot.

e qtiffio library : ondersteuning voor tiff-afbeeldingen

e audiofile 0.2.5 : ondersteuning voor lezen/schrijven van audiobestanden [LGPL]

e netcdf 3.5.0 : ondersteuning voor lezen/schrijven van Unidata Network Common Data Form
(netCDF) bestanden [zie netcdf/COPYRIGHT]

¢ libundo 0.8.2 : ondersteuning voor "do/redo" (ongedaan maken/opnieuw) (wordt op dit moment nog
niet gebruikt)

Optioneel worden in LabPlot de volgende programma's/bibliotheken gebruikt indien beschikbaar :
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e GNU scientific library (GSL) : gebruikt voor bijzondere functies in de parser (programma voor het
lezen en herkennen van functies) en de meeste functies voor analyse.

e Fastest Fourier Transform in the West (fftw of fftw3) : gebruikt voor Fouriertransformaties.

e pstoedit : voor exporteren naar *.eps,*.dxf,*.fig, enz.. via pstoedit moet pstoedit zijn geinstalleerd.

® Imagemagick/ImageMagick-C++ : Voor exporteren naar meer dan100 afbeeldingsformaten
moetlmageMagick++ zijn geinstalleerd.

® Qt? Script for Applications : gebruikt voor het maken van scripts en plugins voor LabPlot.

e JasPer library (bibliotheek) : ondersteuning voor het JPEG2000 afbeeldingsformaat

e cdf : ondersteuning voor lezen/schrijven van Common Data Form (CDF) bestanden

Compileren en installeren

Om LabPlot op uw systeem te installeren typt u het volgende in de basismap voor LabPlot:

oe

./configure
make
make install

oe

oe

Omdat bij het installeren van LabPlot autoconf en automake worden gebruikt zou het compileren geen
problemen mogen geven. Voor veel systemen zijn RPM- of DEB-pakketten beschikbaar. Kijk alstublieft op
de download-afdeling van de thuispagina van LabPlot welke platformen worden ondersteund. Indien u een
probleem ondervindt kunt u dat de auteur van LabPlot melden.

Vereisten
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